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1 Introduction

The Long-Distance Sensor Bus (LDSBus) Configuration Utility (v1.2.4.0) enables configuration of an
LDSBus to be connected to an LDSBus host system.

The tool has two main menu functions:

e LDSU (LDS Unit) Project
e LDSBus Project

1.1 LDSU (LDS Unit) Project

An LDSU Project can be created to configure LDSBus Devices (Sensors/Actuators) before they are
connected to the LDSBus. The LDSU (sensor or actuator) is attached to the LDSU port of the LDSBus
USB Adapter. LDSU configuration, firmware update, calibration and communication tasks can be
performed directly on the device.

1.2 LDSBus Project

The LDSBus Project is used when in-situ configuration, firmware update, calibration and
communication tasks are to be performed on LDSUs. This mode is useful when devices have already
been deployed in the field and removing them from the bus is not convenient or not possible. The
LDSBus project provides an estimate of the total power consumed over the LDSBus, which is useful
when considering the power limitations of the LDSBus Host to which the LDSBus is attached. It is
possible to view the detailed information about any LDSBus device on the bus.

1.3 What's New in Version 1.2.4.0?

e Added support for the following devices -

LDSBus 4CH Solid State Relay (SSR)
LDSBus Air Quality Sensor (AQS)
LDSBus Gas and TrueVOC Sensor
LDSBus Modbus/SDI-12 adapter sensor

O O O O

The recovery of primary firmware corruption in LDSU Project
Added ftd2xx.dll file to release package to resolve “unable to find ftd2xx.dll” error

1.4 Known Issues and Limitations

None. Please report any issues or feedback to support@brtsys.com
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2 Hardware Setup Pre-requisites

The following components are required to create a LDSU or LDSBus Project:

Windows based PC
USB Type A to Type C Cable
LDSBus USB Adapter

LDSBus Device(s) using RJ12/11 cable(s) to RJ12/11 cable(s) or RJ12/11 cable(s) to JST
4/6 cable(s)

For LDSBus Project Only:
e LDSBus HVT Junction (s)

e CAT 5e RJ45 to RJ45 Cable (s)
e 24VDC/18W Power Adapter

2.1 LDSU (LDSBus Unit) Project

TYPE -C

wia - LDSBus USB Adapter 9
J5T 4/8 pin
PC HS ——E

TYPE -A o OR .
[ ] QFUH}’R.III /;r RI2/RILL Device
)

LD5Bus

Figure 1 - LDSU Device (Sensors / Actuators) Connection Diagram

Step 1: Connect the LDSBus USB Adapter to the Windows PC using the USB-C to USB-A cable.
(Or a USB-C to USB-C cable, if the PC has Type-C USB Ports)

Step 2: Connect the LDSBus Device to the cable at one end.

Step 3: Connect the other end of the cable to the LDSBus USB Adapter as shown in Figure 1.

For instructions on configuring the LDSBus device, refer to the Software section.
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2.2 LDSBus Project

RiS{CATSe]

RILE R

TR A L . 4 4
[ ! ot T

o © - -
LR ST 46 gin

RIS ST 4 pen

Figure 2 - LDS Bus - HVT Junction in LDSBus System - Connection Diagram

Step 1: Connect the LDSBus USB Adaptor to the Windows PC using the USB-C to USB-A cable
(or a USB-C to USB-C cable if the PC has Type-C USB Ports).

Step 2: Connect a 24VDC/18W power adapter to the DC jack and turn it ON. The LDSBus and
devices will be powered by software.

Step 3: Using an RJ45 (CAT5e) cable, connect the first HVT-Junction to the USB Adapter.
LDSBus devices connected to the LDSBus HVT-Junction must be preconfigured through
LDSU Project.

Step 4: In case of more than one LDSBus Quad-Junction, chain the connections together using
R1J45 (CAT5e) cables. Ensure that termination is enabled for the last LDSBus device in
the bus through the LDSU Project.
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3 Installing LDSBus Configuration Utility

Following are the steps to install LDSBus Configuration Utility for the first time -

1. Download the installation package from BRTSys Website -

https://brtsys.com/resources/software/brtsys-utility-tools

2. Extract the Zip file and run the Setup (.exe) file provided with the installation package.

&

LDSBusConfigura
tionUtility_Setup_
v1.24.0.3.0.0

3. A Welcome message appears along with LDSBus Configuration Utility Installer Wizard. Click

[Next].

O LDSBus Configuration Utility — X

(0] Welcome to LDSBus Configuration
Utility Installer
Setup will guide you through the installation of LDSBus
Configuration Utility.
It is recommended that you close all other applications
before starting Setup. This will make it possible to update

relevant system files without having to reboot your
computer.,

L Click Mext to continue.,

2.
-
an
v
o
-

Figure 3 - Setup Wizard - Welcome Screen

4. A License Agreement is displayed. Click [I Agree] to proceed.

_B LD5Bus Configuration Utility - X
‘ License Agreement
Please review the license terms before instaling LDSBus
@ Configuration Utility.

Press Page Down to see the rest of the agreement.

iThese license terms constitute a contract between you and BRT SYSTEMS FTE LTD. ~
Flease read the license terms through carefully. They apply to all software and the

related products from BRT SYSTEMS FTE LTD and, if applicable, to the media on which

you received these. These terms also apply to all updates or bug fixes as well as to all

user manuals, programming instructions and other documentation, supplements and
support services offered by BRT SYSTEMS PTE LTD. If any other terms are induded with
the fore-mentioned products, they shall be applicable.

1. License Terms
By agreeing to these license terms, you acknowledge their validity fully and without W

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install LDSBus Configuration Utility.

< Back 1 Agree Cancel

Figure 4 - Setup Wizard - License Agreement
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NOTE:
At any point of time, during the installation, users may click [Back] to navigate to the
previous window or click [Cancel] to abort the installation process.

¢

5. Select or edit the Start Menu Folder Name. Click [Next].

# LDSBus Configuration Utility — X
‘ Choose Start Menu Folder
X Choose a Start Menu folder for the LDSBus Configuration Utlity
@ shortcuts,

Select the Start Menu folder in which you would like to create the program's shortcuts. You
can also enter a name to create a new folder,

| DSBus Configuration Utility]

7-Zip A
Accessibility

Accessories

Administrative Tools

Amazon

Atlassian

Bandicam

Bridgetek

CMake

Device Monitoring Studio

Edipse

Electronic Team v

Figure 5 - Setup Wizard - Start Menu Folder Selection

6. Select a "Destination Folder” for installing the files. Accept the default folder or
click [Browse] to specify a different location. Click [Install] to start the installation.

_a LD5Bus Configuration Utility — >
N Choose Install Location
I @ Choose the folder in which to install LDSBus Configuration Utility.

Setup will install LDSBus Configuration Utility in the following folder. To install in & different
folder, dick Browse and select another folder. Click Install to start the installation.

Destination Folder

| ::\Program Files (x86)\BRTSystems'.DSBus Configuration Utility | Browse. ..

Space required: 6.8 MB
Space available: 11.4 GB

< Back Install Cancel

Figure 6 - Setup Wizard - Installation Location Selection
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7. A progress bar indicates that the installation is in progress.

O LDSBus Configuration Utility

Installing

Please wait while LDSBus Configuration Utility is being installed.

Extract: ScottPlot.dll... 100%

Extract:
Extract:
Extract:
Extract:
Extract:
Extract:

License, txt... 100%

Qutput folder: C:\Program Files (x&6)\BRTSystems\ . DSBus Configuration Utility
Extract:
Extract:

LDSBusConfigurationUtility.exe... 100%
FTD2%%_MET.dll... 100%

Newtonsoft. Jzon.dl..
LDSBuslib.dil... 100%;

. 100%

System.ValueTuple.dll... 100%:
System.Drawing. Common.dll... 100%;

ScottPlot.dll... 100%

< Back Mext = Cancel

Figure 7 - Setup Wizard - Installation Progress

8. Upon successful installation, click [Finish] to close the setup. Select the check box to run the
utility (optional).

O LDSBus Configuration Utility

7p

-
N
)
-

Installed Successfully

LDSBus Configuration Utility has been installed on your
computer,

Click Finish to dose Setup.

Run LDSBus Configuration Utiity

< Back Cancel

Figure 8 - Setup Wizard - Installation Complete
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9. By default, the LDSBus Configuration Utility is installed in this path - "\Program Files
(x86)\BRTSystems\LDSBus Configuration Utility."”

A = | BRTSystems = O X

Home Share View o

“~ v A « Program Files (x86) > BRTSystems ¥ v O Search BRTSystems

) Mame Date modified ype Size

7 Quick access
LDSBus Configuration Utility 13/10/2022 1:23 PM File folder
@ OneDrive - Personal
~ & This PC
J 3D Objects
I Desktop
=| Documents

* Downloads

Figure 9 - LDSBus Configuration Utility Installation Folder location

10. The LDSBus Projects folder is the default folder that contains the projects saved by the utility.

7| = | BRTSysterns - [m] x
Home Share View 0
« v A » ThisPC » Documents » BRTSystems » v O Search ERTSystems

e MName Date modified Type Size
3 Quick access
LD%SBus Projects

5| Documents
3 LDSBus_Pytheon_SDK
& Downloads LDSBusPythenSDK_v2.0.0
| Pictures LDSU Projects
Figure 10 - LDSBus Projects Folder Location
NOTE:

To install an updated version of LDSBus Configuration Utility, download the installation
package from https://brtsys.com/resources/software/brtsys-utility-tools and run the
setup.exe file. An uninstaller will run and remove the previous package and information
from the system. First-time installation will not show the uninstaller. Refer to Section
Error! Reference source not found. for the installation steps.

&
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4 LDSBus Configuration Utility — GUI Overview

LDSBus Configuration Utility

File Settings About

Figure 11 - LDSBus Configuration Utility User Interface

4.1 Default Menu bar

By default, the menu bar contains File, Settings and About menu options.

File Settings About

4.1.1 File Menu

In the menu bar, the first item is the File menu. It contains commands that are used to manage
Projects, such as New Project, Open Project, and Save Project etc.

File Settings About

New Project »
Open Project
Save

Save As

Close
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Menu Item Description

New Project To create a new LDSU / LDSBus projects

Open Project To open or retrieve an existing LDSU / LDSBus project.

Save To save the project. The file is saved with an “.ldsuproj” extension for
LDSU projects and an “.ldsbusproj” extension for LDSBus projects.

Save As To choose a different destination and file name to save the current
project. The file is saved with the extension ".ese".

Close To close the project

Table 1 - File Menu Items and Description

4.1.2 Settings Menu / Interface

From the menu, click the Settings option to access the Settings interface. The settings screen lists
the available LDSBus USB Adapter’s serial number. Click Refresh icon to get the new devices

(if any).

LDSBus USB Adapter

DTSNLBUWA a1C

Select ‘ Cancel

Figure 12 - Settings Interface

1. Select the required adapter from the dropdown list.
2. Upon selecting the adapter, click [Select] to use the adapter. Alternately, click [Cancel] to
return to the previous screen.

4.1.3 Additional Menu (based on the selected Project)

LDSU Project

File LDsU Commands Firmware Update € ings About

LDSBus Project

File LDSBus Commands . ing: About
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5 LDSU (LDSUnit) Project

5.1 Creating a New LDSU Project

To create an LDSU Project -

1. Choose the LDSBus USB Adapter from the Settings menu. Refer to Section 4.1.2.

LDSBus Configuration Utility

Settings

LDSBus USB Adapter

CETTEE N ©

Select Cancel

Figure 13 - LDSBus USB Adapter Selection

2. To create an LDSU project, click File > New Project > LDSU Project.

LDSBus Configuration Utility

File | Settings  About

New Project LDSU Project

Open Project LDSBus Project

Figure 14 - Project Type Selection Menu
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3. Based on the selected project, the application title will be displayed. For example, if the selected
project type is "LDSU Project,” then the title displayed will be "LDSBus Configuration Utility -

LDSU Project.” Enable the LDSU port power on the LDSBus Device connected to the LDSBus
USB Adapter. Click [Scan].
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LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

rLDSU Port Power

Status: Off

Figure 15 - LDSU Project Interface

4. Upon finding a device, the information related to the connected LDSBus Device will be displayed.

The details of the sensor device are displayed at the bottom of the interface. Except for LDSU
ID; LDSU Termination Status and Nickname all the other fields are non-editable.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Enable

L 152160005

LDSU ID

Serial Number s

LDSU Termination

Product Name LDSBus Thermocouple Sensor

Nickname LDSBus Thermocouple Sensor
LDSU Class ox8001

Manufacture Date ST

Calibrated Temperature (°C) 25

Calibrated Date Not Applicable

Number of I2C Devices 2

Software Version 2.3

I2C Devices

Manufacturer :
PartNumber
Addr
Capability
Report Rate
Class ID :

Bridgetek Pte Ltd.
BRT-VDEV

Manufacturer : MICROCHIP

Figure 16 - LDSU Project Interface
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5. Configure the following LDSU Device settings, if required:

oSy 10
LDSU Termination CHEY - W

Nickname LDSBus 4inl Sensor

Update

Figure 17 - LDSU Device Settings

LDSU ID: Default is set as '126". Change the ID accordingly based on the number of devices
that will be connected to the LDSBus. For example, if you will be connecting more than one
LDSBus Device on the bus, configure the first device with an ID of ‘1, second device with an ID
of ‘2" and so on. Each LDSBus Device must have a unique ID.

LDSU Termination: Default is set as ‘Off.” Ensure termination for the last LDSBus Device on
the bus is set as ‘On.’

Nick Name: Default is set as the product name. Change the device name accordingly. The
device name set will be reflected in the LDSBus Host System.

Click [Update] to save any changes.

Click [Calibrate] to start the calibration. Refer to Section 7 for more information on the
Calibration procedure.

If new firmware is available for update, a confirmation window is displayed Click [Yes] to
proceed with the firmware update, refer to Section 5.2 for more information on firmware update
for LDSU project. Alternately, click [No] to cancel.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Sett s About

LDSU Port Power
Tt o Free

LDSU
uuID 1L51101812925240860001
LDSU ID “

Serial Number [EEEE

LDSU Termination off ~
LDSBus CO2 Sensor

Product Name
roduc lame N ETa LDSBus CO2 Sensor

LDSU Class 0x8611
Update

Manufacture Date HE

Calibrated Current (mA)

Calibrated Voltage (mV) 5146 New firmware a\.'ailable_far' upgate, update to latest
firmware?

Calibrated Temperature (°C) 25

Calibrated Date

Number of I2C Devices

Software Version

» : BRT Systems Pte Ltd. Manufacturer : ROHM Semiconductor Manufacturer : Sensirion Manufacturer : Sensirion
BRT-VDEV 3OFVC PartNumber : SCD40 r mb: SCD46e
62

bility
rt R

Figure 18 - Firmware Update - Confirmation
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5.2 Firmware Update

This function allows users to update the device firmware. The Configuration Utility installer file will
include all supported LDSU devices firmware; users cannot select their own firmware. To update

firmware,

1. Select Firmware Update from the menu. a confirmation window is displayed. Click [OK] to
proceed with the firmware update. Alternately, click [Abort] to cancel.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands

LDSU Port Power

Status On

LDSU

uID

Serial Number

Product Name

LDSU Class

Manufacture Date
Calibrated Current (mA)
Calibrated Voltage (mV)
Calibrated Tem) ture (°C)
Calibrated Date

Number of I2C Devices

Software Version

I2C Devices

Manufactu

PartNumb. RT-VDEV

1leee
2x0100

ms
Class ID :

Bridgetek Pte Ltd.

are Update Settings  About

B Browse unv Files

Look n: |

g

Quick access

Desktop

150301 v @& mr
Date medified
19/9/2022 5:55 PM

Name

[7] LDSU_Thermocouple.unv

Libraries

<

Bus Thermocouple Sensor

W

File name: i

Files of type un files (*unv)

Open as read-only

Manufacture MICROCHIP

capa y
Report Rate
Class ID :

1leee
ox0100

ms

Figure 19 - Firmware Update / File Browser Interface

2. Upon selecting a valid firmware package, a confirmation window is displayed. Click [OK] to
proceed with the firmware update. Alternately, click [Abort] to cancel.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands

LDSU Port Power

Serial Number
Product Name
LDSU Class

Manufacture Date
Calibrated Current (mA)
Calibrat

Calibrated Temp
Calibrated Date

Number of I2C D

I2C Devices
Manufacturer :
PartNumber : BRT-VDEV
Address ]
Capability : @
Report Rate
Class ID :

1008 ms
24

Firmware Update

BRT Systems Pte Ltd.

Settings  About

1511810129252400001
4541ECBE

LDSBus €02 Senseor

Confirm firmware update?

Manufacturer :
PartNumber
Addre: B
Capab: y
Report Rate
Class ID :

ROHM Semiconductor
BH1738FVC
29

Manufacturer :
PartNumber
Address
Capability
Report Rate
Class ID :

CD40

0 ms

Sensirion

LDSBus CO2 Sensor

Manufacturer :
PartNumber

Sensirion

Capability
Report Rat.
class ID :

Figure 20 - Firmware Update Confirmation Window
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OR

If the device is already updated with the latest firmware, an appropriate warning message is
displayed. Click [Yes] to overwrite the existing version or [No] to cancel the firmware update.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

LDSU Port Power

Status: On

L

rial Number 3A24E6

product Name LDSBus Thermocouple Sensor
LDSU Class

Manufacture Date

Calibrated Current (mA)

Device already updated with 1. Firmeare.

Continue to Overwri

Calibrated Voltage (mV)
Calibra

Calibrated Date

Number of I2C Devices

Software Vi

I2C Devices

Manufacturer : Bridgetek Pte Ltd.
PartNumber : BRT-VDEV

Addre : 0

Capability : @

Report Rate : 1000 ms

Class ID : @xB816@

Manufacturer : MICROCHIP
PartNumber : MCP9668
Address : @,

Capability : @

Report Rate : 1000 ms
Class ID 108

LDSBus Thermocouple Sensor

Figure 21 - Firmware Overwrite Alert Window

3. A dialog window with the information about the current firmware version and the new firmware

version that will be installed, is displayed. Click [OK] to proceed.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

LDSU Port Power

Ls11@8101
4541ECBE
Product Name LDSBus €02
LDSU Class
Manufacture Date
Calibrated Current (mA)
Calibrated Voltage (mV)
Calibrated Temperature (
Calibrated Date
Number of I2C Devices

Software Version

Devices

Manufacturer : BRT Systems Pte Ltd.
PartNumber BRT-VDEV

Address : 0x00

Capability Q

Report Rate 1088 ms

Class ID : 304

Manufacturer : ROHM Semiconductor Manufacturer :
PartNumber BH1738FVC
Address : ©x29
Capability Q

Report Rate 1088 ms
Class ID : 0x0401

Address : @x62
Capabili 1
Report Rate
Class ID

5080 ms

LDSBus CO2 Sensor

Sensirion Manufacturer : Sensirion
PartNumber SCD48

PartNumber 5CD48
Address : ©:
Capability 1

Report Rate 508808 ms
Class ID : 100

Figure 22 - Firmware Version Information
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4. A firmware has release note (if any) will pop up. Click [OK] to proceed with the firmware update.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update ing About

LDSU Port Power
Status: On

LDsU :
UUID Ls11g Firmware releas

[Feadme Genersted automaticaly on Mon 06/03/2023_16:08:06.67]
[

- =
Serial Number A541E
release note for LDSBus_Co2_SCD4D Adapter and related assets.

is is the
Product Name VSTVl 05Bus_Co2_SCD4D Adapter Fimware Package Corterts

Product ID : (x8011
LDSU Class el Fimivare Version : 0423
(Change log

Manufacture Date 1. Readn Issus fixed

2. Fimware build date added - Build date 06/03/2023

Calibrated Current (mA) 3. BSP Version appended at the end of the buid date

Calibrated Volt.
Calibrated Temper
Calibrated Date
Number of I2C Devices

Software Version

Devices

BRT S
: BRT-VDEV

Report Rate
Class ID : ¢

LDSBus CO2 Sensor

alibrate

ensiri Manufe : Sensi
SCDae er : SCD4B

Figure 23 - Firmware Release Note

5. Depending upon the status of the firmware update, an appropriate message indicating the same

is displayed. Click [OK] to close the window.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update i About

LDSU Port Power

uuID

Serial Number
Product Name
LDSU Class
Manufacture Date

Calibrated Current (mA)

Calibrated Voltage (mV)

Firmsare Update Successful
Calibrated Temperature

Calibrated Date

Number of I2C Devices

Software Ve

I2C Devices

Manufacturer
B Number
Add
Capability :
Report Ra
Class ID

LDSBus Thermocouple Sensor

Figure 24 - Firmware Update Successful Message Window
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Firmware Update Unsuccessful

Figure 25 - Firmware Update Unsuccessful Message Window

Invalid binary file

Figure 26 - Firmware Update Error Message Window

5.3 LDSU Command Interface

The LDSU command interface is used to communicate with the LDSU module by selecting the
command from the list of support commands. The command settings are available only if the device
is found on the bus. To access the Commands window,

1. Select Commands from the menu.

LDSBus Configuration Utility-LDSU Project

File hrmware Update Settings About

LDSU ID 126 (Bx7E)

Commands Response
<Command without response>

Command

4:48.4680636

Figure 27 - LDSU Project - Commands Interface
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2. The Commands interface is displayed.
LDSU ID - Displays the selected Device ID
Command - Displays a list of LDS Commands in a drop-down box
Response — Upon selecting a command and clicking [Send], the device response will extract the
packets and display them in the response box. Refer to Table 2 for the list of commands with
response and without response. Refer to Figure 29 for a sample command with response. Refer

to Figure 30 for a sample command without response.

LDS Message Logger — Displays the query and response logger.

Figure 28 - LDSU Project - Commands List

Refer to Table 2 for the list of commands.

Commands with payload and response READN; WRITEN; READ; ECHO
Commands without payload and no response RESET; IDENTIFY;I2CREGOFF
(Same UI)

Commands with payload and no response I2CREGON; SETI2CSPEED; WRITE
Commands without payload and with response INFO; STATUS,; GETUUID

Table 2 - List of Commands

LDSBus Configuration Utility-LDSU Project

File LDsU Commands Firmware Update Settings About

Target LDSU

LDSU ID 126 (@x7E)

Commands

Command
Checksum

Send

- 13:54:48.4680636

Figure 29 - Sample Command with Response
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LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Tar LDSU

LDSU ID

Response
“ommand without response>

IDENTIFY

Figure 30 - Sample Command without Response

5.4 Saving LDSU (LDSUnit) Project

Upon creating an LDSU Project, users may save the project. To save a project -

1. Click File > Save.

LDSBus Configuration Utility-LDSU Project
LDSU Commands Firmware Update Settings About
New Project » e

Open Project Enable

Save As LDSU ID

Close [ LDSU Termination -

Froauct name T s LDSBus C02 Sensor

Update

LDSU Class
Manufacture Date
Calibrated Current (mA)
Calibrated Voltage (mv)
Calibrated Temperature (
Calibrated Date
Calibrate

Number of I2C Devices

Software Version

I2C Devices

Manufacturer : BRT Systems Pte Ltd. Manufacturer : ROHM Semiconductor Manufacturer : Sensirion Manufacturer : Sensirion
PartNumber : BRT-VDEV PartNumber : BH173@FVC PartNumber : SCD4@ PartNumber : SCD4@
Address : Addre Addre Addr 2

Capability e Capability : @ Capability : 1 Capability

Report R : 1000 ms Report Rate : 1000 ms Report Rate : 5008 ms Report Rate : 5000 ms
Class ID ox@304 Cla I oxe4e1 Class ID : ©x@8384 Class ID 100

Figure 31 - Save LDSU Project
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2. By default, the project will be saved under this location - /My Documents/BRTSystems/LDSBus
Projects. However, users may select a preferred to location to save the project. The LDSU project
will be saved with a file extension - .ldsuproj.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Sett. About

Enable

S 5 Save LDSU Project Files

Gorsiall fir e 0e i < BRTSys... > LDSBus Projects Search LDSBus Projects

Product Name Organize = New folder

LDSU C1. 2 O ThisPC "~ Name Date modified
ass e

B 30 Objects |1 cozsensor.dsuproj 11/10/2022 10:06 AM LDSUPRO! File
[ Desktop
Calibrated Cu t ) 5 [ Documents
& Downloads
D Music

Manufacture Date

Calibrated Voltage

Calibrated Temperature ) =] Pictures

Videos
Calibrated Date

Fil 3
Number of I2C Devices fename “

Save astype: | LDSU Project files (* Idsuproj)
Software Version

I2C Devices———————————————— ~ Hide Folders Cancel

Manufactu : BRT Sys s Pte Lta. rian T - Flanutact

: BRT-VDEV rtN BH1730FVC PartNumb:
Ad

Capabilit
1000 ms
Class ID :

Figure 32 - Default Location to Save LDSU Project

3. The picture below shows a sample LDSU Project saved under the default location.

I ¥ = | LDSBus Projects - O b4

Home Share Wiew 0

« v 4 <« BRTSy.. » LD5Bus Projects v | O Search LD5Bus Projects

(o) MName Date modified Type Size

7 Quick access
| | CO2Sensor.ldsupraj 110

134 AM LDSUPROI File 2KB
o Onelirive - Personal
& This PC
M 3D Objects

[ Desktop

= Decuments

{ Downloads

J’! Music

| Pictures
Videos
Windows (Cs)

- Recovery Image (D:)

>
o e

1item =

Figure 33 - Sample LDSU Project Saved under default location

’ NOTE:

5

4 A copy of the file can be made in a different folder or with a different name by clicking the
File > Save As.

23
Product Page
Document Feedback Copyright © BRT Systems Pte Ltd


https://brtsys.com/resources/software/brtsys-utility-tools
mailto:docufeedback@brtchip.com?subject=Document%20Feedback:%20BRTSYS_AN_001%20Version%201.5

BRTSYS_AN_001 LDSBus Configuration Utility Guide

Document Version 1.5
OBRTSys

Document Reference No.: BRTSYS_000014 Clearance No.: BRTSYS#038

5.5 Opening a LDSU Project

To open an existing LDSU Project,

1. Click File > Open Project.

LDSBus Configuration Utility-LDSU Project

DSU Commands Firmware Update Settings About

Open Pro; Enable

Save

) 151161016831
Save As LDSU ID
.- 00800466

Close
Proauct Name LDSBus CO2 Sensor

LDSU Termination

Nickname LDSBus CO2 Sensor
LDSU Cla
Update
Manufacture Date
Calibrated Current (mA)
Calibrated Voltage (mv)
Calibrated Temperature (°C
Calibrated Date

. Calibrate
Number of I2C Devices

Software Version

I2C Devices
cturer : BRT Systems Pte Ltd. Manufacturer : Sensirion Manufact: : Sensirion
BRT-VDEV PartNumber : SCD4@ 5CD49
Address

Figure 34 - File - Open Project Menu

2. Browse for the project in the File browser and select the LDSU Project. By default, the Files of

type filter box display LDSBus Projects (*.ldsbusproj). Click the box and select a LDSU Project.
Click and open the LDSU Project.

D o o D 0
A
]
D Browse LDS Project x
Lookin: [ || LDSBus Corfiguration Uty v @ @F e mEr 2o ~
* Name . Date modified wpe forf v
. DefaultCalibrationData 13/10/2022 1:45 PM File fe
Quick access resources 13/10/2022 1:46 P Filef | LDSBus CO2 Sensor
7 settings 13/10/2022 1:46 P Filefc
Deskiop
A n
Libraries
This PC
" < >
L P I v [Coee ]
Network
Fies of type: LDSBus Projects(" ldsbuspro]’) - Cancel

B4 0pen as read-only
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Browse LDS Project
Look in: ‘ Projects v | (<] ¥ e E-
% Name Date medified
MNe items match your search.
Quick access
Desktop
m
Libraries
This PC
* <
Ld File name ‘ hdl |
MNetwork
Files of type [LDSBus Projects(" Idsbusproy’) |
LD5U Projects(" Idsupro)
LDSBus Projects(* |dsbusproj*)

O Browse LDS Project ¥
Loak in: | LDSBus Projects “ ‘ (€] ¥ = M~
;} MName Date medified Type
| | CO2Senser.ldsuproj 11/10/2022 9:34 AM LDSU
Quick access
Decktop
m
Libraries
This PC
‘ < b3
I: ld File pame: ‘ ~ | I Open
MNetwork
Files of type: LDSU Projects(” Idsuproj) ~ Cancel
Open as read-only

LDSBus Confi

File LDSU

LDSU Port Powe

Status: On
uuID

ial Number
Product Name

LDSU Class

Commands

Figure 35 - File Browser - LDSU Project Selection

guration Utility-LDSU Project

Firmware Update

r

The LDSU project is opened in the project window.

About

Enable

LS116101e:

0466

LDSBus

Manufacture Date

Calibrated Cu
Calibrated Vo
Calibrated Te
Calibrated Da
of I2C

Number

Software Vers

I2C Devices

Manufactur

rrent (mA)

ltage (mV)

mperature (°C) 25

te Mot Applicable

5

Devices

ion “o

: BRT Systems Pte Manufactur

BRT-VDEV

Capability
~t Rat

: ROHM Semiconductor

Figure 36 - LDSU Project Window

LDSU ID
LDSU Termination

Nickname

Manufacturer

Capability :
Report Rate
Class

LDSBus CO2 Sensor

Update

: Sensirion

Refer to Section 5.1 for more information on creating the LDSU project.

Manufactur : Sensirion

Capability
Report Rat
Class ID :
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6 Creating a New LDSBus Project

To create an LDSBus Project -

1. Click File > New Project > LDSBus Project.

LDSBus Configuration Utility

Figure 37 - Project Type Selection Menu

2. Based on the selected project, the application title will be displayed. For example, if the selected
project type is "LDSBus Project,” then the title displayed will be "LDSBus Configuration Utility -
LDSBus Project.” Enable the LDSU port power on the LDSBus Device connected to the LDSBus
USB Adapter. Click [Scan] to scan the devices in the bus.

LDSBus Configuration Utility-LDSBus Project

File LDSBus Commands Settings About

Figure 38 - LDSBus Project Interface

3. Upon finding the device(s), information related to LDSBus Device will be displayed. There are
two view options available, namely LDSU IDs View and LDSU List View. By default, LDUS IDs
view is displayed.

LDSBus Configuration Utility-LDSBus Project
File  LDSBus Commands Settings About

LDSBus Power

Status: on Enable

LDSU IDs LDSU List

Total Online LDSUs: 3 Estimated Power Consumption (mW) :
New Online LDSUs: 3

Filter: |3

13

Figure 39 - LDSBus Project Interface (LDSU IDs View)
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4. The following details are displayed as part of the LDSU IDs view -

e Total number online LDSU devices: Displays the total number of LDSBus Devices which are
physically connected and detected on the bus.

e New online LDSU devices: Displays the total number of new LDSBus Devices which are
physically connected and detected on the bus.

e FEstimated Port Power Consumption: Displays the estimated total power consumed by the
bus

e Online/Offline Device Filter: To filter all, online, offline, or new online LDSBus Devices.
LDSBus Devices ID displayed based on filtering results.

LDSU IDs LDSU List

Total Online LDSUs: 3 Estimated Power Consumption (mW) : 16082
New Online LDSUs: 3

Filter: All

13 a7

5. Switch to LDSU List to view the basic device information. The list view displays all the LDSBus
Devices connected in the bus with some device information. The LDSU List view displays the
following information - Device UUID; Device’s Nickname,; Date on which the device was last
calibrated; Termination Status (ON / OFF).

Click Details to view the detailed information about the device.

LDSBus Configuration Utility-LDSBus Project

File LDSBus Commands Settings About

LDSBus Power

Status: On Enable

LDSU IDs LDSU List

Nickname Last Calibrated Termination Details

2022-Jun-88 oFF

[

Figure 40 - LDSU List Interface
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6. Upon clicking the Details link, the detailed LDSU information is displayed.

LDSU Information LDSU Information

uuID LSTI01O0KXXXX22616 LCe1116181042200090

Serial Number rial Number 58D365A5

Product Name LDSBus CO2 Senser Loduct Name LDSBus 2CH Relay

LDSU Class @x8011 LDSU Class

LDSU Termination off LDSU Termination off

Nickname LDSBus €02 Sensor Nickname LDSBus 2CH Relay

Calibrated Current (mA) 58 Calibrated Current (mA) 64

Calibrated Voltage (mV) 5140 Calibrated Voltage (mV) 5600
Calibrated Temperature ) > Calibrated Temperature (°C)

Number of I2C Devices : Number of I2C Devices

Figure 41 - LDSU Information
Click [Commands] to access the command interface.
Click [Delete] to remove any of the device from the list.
Click [Calibration] to start the calibration process.

Click [Application] to configure the application types.

6.1 LDSBus Command Interface

The LDSBus command interface is used to communicate with the LDSBus module by selecting the
command from the list of supported commands. The command settings are available only if the
device is found on the bus. Refer to Section 5.3 for more information.

6.2 Saving LDSBus Project

Upon creating an LDSBus Project, users may save the project. The steps for saving a LDSU Project
and LDSBus Project is the same. Refer to Section 5.4 for more information.

6.3 Opening a LDSBus Project

The steps for opening a LDSU Project and LDSU Project is the same. Refer to Section 5.5 for more
information.
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6.4 LDSBus Right Click Functions

To access the dropdown menu of the device under LDSBus project.

1. Right click the device green square box.

LDSBus Configuration Utility-LDSBus Project

File LDSBus Commands Settings About

Enable

LDSU IDs LDSU List

Total Online LDSUs: |3 Estimated Power Consumption (mi) 1682

New Online LDSUs:

Figure 42 - LDSBus Project - LDSU IDs

2. The dropdown menu will be displayed.

LDSBus Configuration Utility-LDSBus Project

File LDSBus Commands Settings About

LDSBus Power

Status: Enable

LDsU IDs LDsU

Total Online LDSUs: 3 Estimated Power Consumption (mW) :

New Online LDSUs:

Filter: [CNNA

2 13 || o7
Tdentify
Device Info
Calibration

Firmware Update

Export

Figure 43 - LDSBus Right Click Drop Down Menu

Common items shown in the dropdown menu are “Identify,” “Device Info,” “Firmware Update,”
“Export,” “Calibration,” “Application Setting,” “Profile Setting,” “RFID Setting” and “Sensor
Configuration” are device related.
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Filter: [ENE

13 97
Identify
Device Info
calibration
Firmware Update

Export

Figure 44 - LDSBus Dropdown Menu
Identify - To send identify command.
Device Info - To view the LDSU device as shown in Figure 41.

Firmware Update - To update device firmware. Refer to Section 6.5 for more details. On firmware
update.

Export - To save the selected unit’s data to LDSU project file.
Calibration - To perform calibration. Refer to Section 7 for more details on calibration procedure.

Application Setting - To configure application Type. Refer to Section 8 for more information related
to application type configuration.

Profile Setting - To configure profile setting. Refer to Section 8.3 for more information on Profile
Setting.

RFID Setting - To configure RFID Setting. Refer to Section 8.4 for more information on Configuring
RFID Setting.

Sensor Configuration - To configure Senor Setting. Refer to Section 8.5 for more information on
Sensor Configuration Setting.

6.5 LDSBus Firmware Update

To update device’s firmware under LDSBus project -

1. Right click and select the device for which the firmware needs to be updated; From the resulting
drop-down menu, click on “Firmware Update” to start the firmware update process.

Filter: All

Identify
Device Info

Firmware Update

Export

Figure 45 - Drop Down Menu - Firmware Update

30

Product Page
Document Feedback Copyright © BRT Systems Pte Ltd


https://brtsys.com/resources/software/brtsys-utility-tools
mailto:docufeedback@brtchip.com?subject=Document%20Feedback:%20BRTSYS_AN_001%20Version%201.5

BRTSYS_AN_001 LDSBus Configuration Utility Guide
Document Version 1.5

-a BR I Sys Document Reference No.: BRTSYS_000014 Clearance No.: BRTSYS#038

2. A confirmation window will pop up. Click [Yes] to confirm the firmware update operation or click
[No] to cancel the update.

Current Version 2.1
Update to Version 2.3

3. If firmware has release note, firmware release note will pop up. Click [OK] to continue start the
firmware update.

Firmware release note

[Readme Generated automatically on Maon 06/03/2023_16:08:06 67]
Introduction

This is the release note for LOSBus_Co2_SCD40 Adapter and related assets.
LDSBus_Co2_SCD40 Adapter Firmware Package Contents

Product 1D : (8011
Fimware Version : (x23

2. Firmware build date added - Build date 06/03/2023
3. BSP Version appended at the end of the build date

4. LDSBus Firmware update status window will pop up to show the progress of the firmware update.

ID: 11 UUID: LS10010181842200036

Update firmware, this will take a while

ST
944

5. Upon successful completion of update, an appropriate message indicating the same will be
displayed. Click [OK] to return back LDSBus Project window.

Firmware update completed

31

Product Page
Document Feedback Copyright © BRT Systems Pte Ltd


https://brtsys.com/resources/software/brtsys-utility-tools
mailto:docufeedback@brtchip.com?subject=Document%20Feedback:%20BRTSYS_AN_001%20Version%201.5

BRTSYS_AN_001 LDSBus Configuration Utility Guide
Document Version 1.5

-a BR I Sys Document Reference No.: BRTSYS_000014 Clearance No.: BRTSYS#038

7 Sensor Calibration Procedure

Sensor calibration is the process of aligning the sensor's output to known reference values to ensure
accurate and consistent measurement performance. It is recommended to follow the calibration
procedure before taking measurements to ensure accurate results. Before starting the calibration
procedure, ensure that the required equipment and buffer solution are prepared.

Note : For pH, Electrical Conductivity (EC), Salinity, and ORP sensors, calibration must be performed
using certified buffer or standard solutions of known reference values.

e pH calibration requires two-point using the below buffer solutions:
o pH 4.01 - Acidic range
o pH 7.00 - Neutral (mandatory reference point)

e EC calibration requires two-point using the below buffer solutions:
o 1413 pS/cm - General-purpose calibration
o 12.88 mS/cm - High conductivity range

e ORP calibration requires single-point calibration using standard ORP reference
solutions:
o 225 mV - Reducing range

From V1.2.2 of the configuration utility, sensor calibration may be performed in-situ on the LDSBus,
i.e. the sensor adapter and probe need not be removed from the bus and prevents any disruption to
the existing setup in the field. For in-situ calibration, detach the RJ-45 cable from the gateway
LDSBus Port and attach it to the RJ-45 interface of the LDSBus USB Adapter and open an LDSBus
Project in the utility, instead.

7.1 LDSBus pH Sensor Adapter Calibration

To calibrate pH Sensor Adapter, follow these steps -

1. Click [Calibrate] from the LDSU / LDSBus Project interface.

LD5Bus Configuration Utility-1DSU Project

File LErSU Commands Firmaars
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An information window prompting the users for Power Selection is displayed. If users want to
continue calibration with USB Adaptor 5V, just select "USB Adaptor 5V” option. Alternately, if
users want to switch to T-Junction to calibrate sensor, they just select “T-Junction 24V” option.
We strongly recommend user to use T-Junction for sensor calibration to achieve better accuracy.
After selecting the power selection, click [OK] to continue or click [Cancel] to cancel the
calibration process.

Calibration Power Selection

er Selection

® USB Adaptor 5V O T-Junction 24V

Ok Cancel

3. If "USB Adaptor 5V” selected, a confirmation window will pop up to confirm user connect the
sensor to the USB Adaptor RJ11 port. click [OK] to continue or click [Cancel] to cancel the
calibration process.

Attach LDSBus Sensor Adaptor to the LDSBus USB
Adaptor RJ11 port.

Cancel

If “T-Junction 24V” selected. LDSU Calibration requires 24V Power supply. Remove the sensor
module and attach to the HVT-Junction connected to the LDSBus Port. Click [Ok] to continue or
[Cancel] to quit the calibration process.

Calibration requires 24V LDSBus Power.
Remove and attach Se ~ adapter to a LDSBus HVT-
Junction connected to the LDSBus Port.

Cancel

Upon clicking [Ok], a confirmation window prompting the user to switch from LDSU Port Power
to LDSBus Port Power is displayed. Click [Ok] to switch. Alternately, click [Cancel] to exit the
calibration process. Upon clicking [OK], the project window will be in disabled mode and the
countdown timer starts.

Switch from LDSU Port Power
to LDSBus Port Power?
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First Point Calibration

4. Upon successful power switch, system will prompt the users to start the calibration. Click [OK].
The interface for the First point calibration for 7pH is displayed. Prepare Buffer solution (7pH and
one more optional). There should be two sets of beakers for each solution. Beaker 1 is used to
clean the probe before a calibration and Beaker 2 is used for the actual calibration measurement.
Temperature can be edited if required. Upon preparing the solutions, click on the Beaker-2 for
Calibration 7pH checkbox.

pH - First point calibration - 7pH pH - First point calibration - 7pH

Temperature Temperature

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 7pH

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 7pH

]
Rinse the probe with distilled water E

Cancel

5. Remove the electrode from its storage solution and rinse it with distilled water in an empty waste
beaker. Upon rinsing the probe with distilled water, click on the Rinse the probe with distilled
water check box.

6. After rinsing, wipe dry with Kimwipes or Shurwipes and click on the Dry the probe with Kimwipes
or Shurwipes checkbox. (Avoid rubbing the electrode because it has a sensitive membrane).

pH - First point calibration - 7pH pH - First point calibration - 7pH

Temperature

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 7pH

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes

©

Cancel

Temperature

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 7pH

Rinse the probe with distilled water
Dry the probe with Kimwipes or Shurwipes

Rinse the probe in beaker-1

Cancel

Use Beaker 1 (7pH) to rinse the electrode. Use Beaker 2 (7pH) to place the electrode to start
the calibration. Rinse the probe in beaker 1 (7pH), then click the Rinse the probe in beaker-1

checkbox.
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8. An information window will appear. Click [Ok] to proceed. The calibration window will be in
disabled mode and the countdown timer starts as shown in the picture. Wait for 60 seconds to
stabilize the readings.

pH - First point calibration - 7pH

Temperature

Prepare

In the next step, the probe has to be
imme in beak 2.
Calibration will take

Dry the|

Rinse t

Cancel

9. Check the result. If the first point calibration is unsuccessful, an error message is displayed.
Click [Retry] to start the first point calibration again (Repeat Steps 5 - 10 until the first point
calibration is successful).

pH - First point calibration - 7pH

Temperature

Prepare

First point calibration fail.
Dry the Offset deviation not within the range of #
- 36.0 mV.
Rinse t

ok
Immerse

Probe offset (Range 13@.8mV)

10. Upon successful calibration, an appropriate message indicating the same is displayed. Click [Ok]
to continue. The Calibration result will be displayed. Click [Next] to proceed with the Second
point calibration.

pH - First point calibration - 7pH

Temperature

Prepare

First point calibration Successful

Origin ReESUTT (Rang oo myv
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Second Point Calibration

11. Upon successfully completing the First Point Calibration, the Second Point Calibration interface
is displayed. Prepare Second buffer solution. There should be two sets of beakers for each
solution. Beaker 1 is used to clean the probe before a calibration and Beaker 2 is used for the
actual calibration measurement. Upon preparing the solutions, click on the Beaker-2 for
Calibration 4.00pH checkbox.

pH - Second point calibration - 4pH pH - Second point calibration - 4pH

Second buffer solution 4. Second buffer solution

Prepare solutions in 2 beakers Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH > Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 4.00pH > Beaker-2 for calibration 4.00pH

Rinse the probe with distilled water

12. Remove the electrode from its storage solution and rinse it with distilled water in an empty waste
beaker. Upon rinsing the probe with distilled water, click on the Rinse the probe with distilled
water check box.

Cancel TarEeil

13. After rinsing, wipe dry with Kimwipes or Shurwipes and click on the Dry the probe with Kimwipes
or Shurwipes checkbox.

pH - Second point calibration - 4pH

Second buffer solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 4.00pH

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes

14. An information window will appear. Click [Ok] to proceed. The calibration window will be in
disabled mode and the countdown timer starts as shown in the picture. Waiting for 60 seconds
to stabilize the readings.

pH - Second point calibration - 4pH

Second buffer solution

Prepare|

, the probe has to be
in be

seconds.

Cancel
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15. Check the result. Upon successful calibration, an appropriate message indicating the same is
displayed. Click [Ok] to continue. The Calibration result will be displayed. Do not remove probe
from beaker, click [Verify] to verify the calibration result against the solution.

pH - Second point calibration - 4pH

Second buffer solution o =
Verification

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 4pH
> Beaker-2 for calibration 4pH

Current reading:
3.99 pH

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes

Rinse the probe in beaker-1 _ ‘ Decline

Immerse the probe into beaker-2

Slope (Range 90%-105%)

Verify Cancel

16. The verification window will display the current reading. Click [Accept] if the current reading is
with reasonable range, click [Decline] if current reading is not acceptable and you can
recalibrate the device again.

17. Click [Update] to flash the calibration data into the device. System will switch power from
LDSBus Port to LDSU Port.

pH - Second point calibration - 4pH

Second buffer solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 4pH
> Beaker-2 for calibration 4pH

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes
Rinse the probe in beaker-1

Immerse the probe into beaker-2

Slope (Range 90%-105%)

Update Cancel

18. If the calibration fails, then appropriate error message is displayed. Click [Ok].

pH - Second point calibration - 4pH

Second

Prepare

Second point calibration fail.
Slope deviation not wit
%-105% .

Immerse

Slope (Range 90%-105%)

Retry
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19. Click [Retry] to do the second point calibration again. (Repeat Steps 13 - 19 until the
calibration is successful) or click [Cancel] to exit the calibration process. Upon cancelling the
calibration process, system will switch power from LDSBus Port to LDSU Port.

pH - Second point calibration - 4pH

Second buffer solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning 7pH
> Beaker-2 for calibration 4.@@pH

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes
Rinse the probe in beaker-1

Immerse the probe into beaker-2

Slope (Range 90%-105%

Cancel

Post Completion or Cancellation of Calibration Process

20. Upon successful completion or cancellation of calibration process, system will switch power from
LDSBus Port to LDSU Port.

Turning off LDSBus Port Power Detach LDSBus Sensor Adapter from the LDSBus HVT-

Junction
and attach to the LDSBus USB Adapter RJ11 port.

21. An information window prompting the users to detach the LDSBus pH Sensor Adapter from the
LDSBus HVT-Junction and attach to the LDSBus USB Adapter RJ11 Port is displayed. Click [Ok].

22. Upon clicking [OK], the project window will be in disabled mode and the countdown timer starts

as shown in the picture indicating that the power switching is in progress.

@ LDSBus Configuration Utility-LDSU Project

File | LDSU  Commands Firmare Update
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7.2 LDSBus EC/Salinity Sensor Adapter Calibration

To calibrate EC / Salinity Sensor Adapter, follow these steps -

1. Click [Calibrate] from the LDSU / LDSBus Project interface to start the calibration.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands

LDSU Port Power

st On

LDSU

UuUID

Serial Number

Product Name

LDSU Class

Manufacture Date
Calibrated Current (mA)

Calibrated Voltage (mV)

Calibrated Temperature (°C)

Calibrated Date

Number of I2C Devices

Software Version

I2C Devices

Firmware Update Settings About

¥ Enable

L505010101042200058
E1FC1231

LDSBus EC Sensor

Nickname

Bx

2822-Jun-16

A8

25

2822-0ct-19

a

2.1

Manufacturer : Bridgetek Pte Ltd.

PartNumber : BRT-VDEV
Address 0xe0
Capability : @

Report Rate 1000 ms
Class ID : @xB8901

LDSU Termination

LDSBus EC Sensor

Calibrate

2. An information window prompting the users for Power Selection is displayed. If you want to
continue calibration with USB Adaptor 5V, just select "USB Adaptor 5V” option. But if you want
to switch to T-Junction to calibrate your sensor, just select “T-Junction 24V"” option, we strongly
recommend user to use T-Junction for sensor calibration to achieve better accuracy. After
selecting power selection, click [OK] to continue or click [Cancel] to cancel the calibration

process.

Calibration Power Selection

Power Selection

® USB Adaptor 5V O T-Junction 24V

0Ok Cancel

3. If "USB Adaptor 5V” selected, a confirmation window will pop up to confirm user connect the
sensor to the USB Adaptor RJ11 port. click [OK] to continue or click [Cancel] to cancel the

calibration process.

Attach LDSBus Sensor Adaptor to the LDSBus USB
Adaptor RJ11 port.

Product Page
Document Feedback

39

Copyright © BRT Systems Pte Ltd


https://brtsys.com/resources/software/brtsys-utility-tools
mailto:docufeedback@brtchip.com?subject=Document%20Feedback:%20BRTSYS_AN_001%20Version%201.5

BRTSYS_AN_001 LDSBus Configuration Utility Guide
Document Version 1.5

-a BR I Sys Document Reference No.: BRTSYS_000014 Clearance No.: BRTSYS#038

If “T-Junction 24V” selected. LDSU Calibration requires 24V Power supply. Remove the sensor
module and attach to the HVT-Junction connected to the LDSBus Port. Click [Ok] to continue or
[Cancel] to quit the calibration process.

Calibration requires 24V LDSBus Power.
Remove and attach Sensor adapter to a LDSBus HVT-

Junction connected to the LDSBus Port.

Cancel

Upon clicking [Ok], a confirmation window prompting the user to switch from LDSU Port Power
to LDSBus Port Power is displayed. Click [Ok] to switch. Alternately, click [Cancel] to exit the
calibration process. Upon clicking [Ok], the project window will be in disabled mode and the
countdown timer starts.

Switch from LDSU Port Power
to LDSBus Port Power?

‘ Cancel

First Point Calibration

4. Upon successful power switch, system will prompt the users to start the calibration. Click [Ok].
The interface for the First point calibration for EC Sensor is displayed. Prepare Buffer solution
(EC Sensor and one more optional). There should be two sets of beakers for each solution.
Beaker 1 is used to clean the probe before a calibration and Beaker 2 is used for the actual
calibration measurement.

EC - First point calibration

Temperature degC
EC Solution 1.413 mS/cm

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning

> Beaker-2 for calibration ‘ E

EC - First point calibration
Temperature
Probe Type
EC Solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water

Cancel Cancel

Temperature/Probe Type/EC Solution can be edited if required. Upon preparing the
solutions, click on the Beaker-2 for Calibration checkbox.

5. Remove the electrode from its storage solution and rinse it with distilled water in an empty waste
beaker. Upon rinsing the probe with distilled water, click on the Rinse the probe with distilled
water check box.
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6. After rinsing, wipe dry with Kimwipes or Shurwipes and click on the Dry the probe with Kimwipes
or Shurwipes checkbox. (Avoid rubbing the electrode because it has a sensitive membrane).

EC - First point calibration EC - First point calibration

EC Solution 1.413 mS/cm EC Solution 1.413 ms/cm

Prepare solutions in 2 beakers Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning > Beaker-1 for probe cleaning
> Beaker-2 for calibration > Beaker-2 for calibration

Rinse the probe with distilled water Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes Dry the probe with Kimwipes or Shurwipes

Rinse the probe in beaker-1 Rinse the probe in beaker-1 ‘ D

Cancel Cancel

7. Use Beaker 1 to rinse the electrode. Use Beaker 2 to place the electrode to start the calibration.
Rinse the probe in beaker 1, then click the Rinse the probe in beaker-1 checkbox.

8. An information window will appear prompting for immersing the probe in beaker 2. Click [Ok]
to proceed.

EC - First point calibration

Temperature degC
Probe Type b

i i EC Solution 1.413 mS/cm
ep, the probe has to be immersed in

beaker-2. Prepare solutions in 2 beakers

Calibration will take 6@ seconds. > Beaker-1 for probe cleaning
> Beaker-2 for calibration

<]

<]

Rinse the probe with distilled water

<]

Dry the probe with Kimwipes or Shurwipes

<]

Rinse the probe in beaker-1

Immerse the probe into beaker-2

@
B

Upon immersing the probe, click on the corresponding checkbox. Wait for 60 seconds to stabilize the
readings.

9. Upon successful calibration, an appropriate message indicating the same is displayed. Click [Ok]
to continue. The Calibration result will be displayed.

First point calibration pass.
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10. Click [Next] to proceed with the Second point calibration.

EC - First point calibration

Temperature
Probe Type

EC Solution

degC
K
1.413 ms/cm

Prepare solutions in 2 beakers

> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes

Rinse the probe in beaker-1

Immerse the probe into beaker-2

First Point Result

Second Point Calibration

11. Upon successfully completing the First Point Calibration, the Second Point Calibration interface
is displayed. Prepare Second buffer solution. There should be two sets of beakers for each
solution. Beaker 1 is used to clean the probe before a calibration and Beaker 2 is used for the
actual calibration measurement. Upon preparing the solutions, click on the Beaker-2 for

Calibration checkbox.

EC - Second point calibration
Temperature
Probe Type
EC Solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

EC - Second point calibration

degC Temperature

N
12.88 mS/cm

‘El

Probe Type

EC Solution

12.88 mS/cm

® L

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water

12. Remove the electrode from its storage solution and rinse it with distilled water in an empty waste
beaker. Upon rinsing the probe with distilled water, click on the Rinse the probe with distilled

water check box.
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13. After rinsing, wipe dry with Kimwipes or Shurwipes and click on the Dry the probe with Kimwipes

or Shurwipes checkbox.

EC - Second point calibration

Temperature degC

Probe Type K

EC Solution mS/cm

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes

EC - Second point calibration

Temperature

degC
B <
12.88 mS/cm

Probe Type
EC Solution

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes

Rinse the probe in beaker-1

14. Rinse the probe in
checkbox.

=
Rinse the probe in beaker-1 B
Cancel

beaker solution. Once done, click on the Rinse the probe in beaker-1

15. An information window will appear prompting for immersing the probe in beaker 2. Click [Ok]

to proceed.

16. Upon immersing the
the readings.

EC - First point calibration
Temperature

Probe Type

EC Solution

Prepare solutions in 2 beakers

> Beaker-1 for probe cleaning
> Beaker-2 for calibration

]

<]

Rinse the probe with distilled water

<]

Dry the probe with Kimwipes or Shurwipes

q

Rinse the probe in beaker-1

Immerse the probe into beaker-2

probe, click on the corresponding checkbox. Wait for 60 seconds to stabilize

EC - Second point calibration

Temperature degC

Probe Type K

EC Solution mS/cm

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water

Dry the probe with Kimwipes or Shurwipes

Rinse the probe in beaker-1

Immerse the probe into beaker-2
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17. Upon successful calibration, an appropriate message indicating the same is displayed. Click [Ok]
to continue. The second point calibration result will be displayed. Do not remove the probe from
beaker, click [Verify] to verify the calibration or click [Cancel] to cancel the calibration.

EC- Second point calibration

Temperature degC
Probe Type K Verification
EC Solution 12.88 mS/cm
Current reading:

Prepare solutions in 2 beakers 12.8844 mS/cm
> Beaker-1 for probe cleaning i
> Beaker-2 for calibration

Rinse the probe with distilled water )
Dry the probe with Kimwipes or Shurwipes Accept Decline
Rinse the probe in beaker-1

Immerse the probe intg beaker-2

Second Point Resu

Verify Cancel

18. The verification window will display the current reading. Click [Accept] if the current reading is
with reasonable range, click [Decline] if current reading is not acceptable and you can
recalibrate the device again.

19. Click [Update] to flash calibration data into EEPROM or click [Cancel] to avoid saving data.

EC- Second point calibration

Temperature degC
EC Solution 12.88 mS/cm

Prepare solutions in 2 beakers
> Beaker-1 for probe cleaning
> Beaker-2 for calibration

Rinse the probe with distilled water
Dry the probe with Kimwipes or Shurwipes
Rinse the probe in beaker-1

Immerse the probe into beaker-2

Second Point Result

Update Cancel

Post Completion or Cancellation of Calibration Process

20. Upon successful completion or cancellation of calibration process, system will switch power from
LDSBus Port to LDSU Port.

Turning off LDSBus Port Power
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21. An information window prompting the users to detach the LDSBus pH Sensor Adapter from the
LDSBus HVT-Junction and attach to the LDSBus USB Adapter RJ11 Port is displayed Connect the
sensor back to the USB adapter after removing it from the Quad T-junction, and then click [Ok].

Detach LDSBus Sensor Adapter from the LDSBus HVT-
Junction

and attach to the LDSBus USB Adapter RJ11 port.

22. In the main window, the calibration date will be updated after the utility scans the device again.

LDSBus Configuration Utility-LDSU Project
File LDSU Commands Firmware Update Settings About

LDSU Port Power

St : On Enable
LDSU

i L565016101642200058
LDSU ID ~

Serial Number E1FC1231

LDSU Termination -
LDSBus EC Sensor

Product Name
roduc ame Nickname LDSBus EC Sensor

LDSU Class
Update

Manufacture Date 2622-Jun-16

Calibrated Current (mA) 40

Calibrated Voltage (mV)

Calibrated Temperature (°C) 25

Calibrated Date 2022-Dec-13 ‘

Number of I2C Devices 1 S

Software Version 2.1

I2C Devices

Manufacturer : Bridgetek Pte Ltd.
~ : BRT-VDEV
)

Capability
Report Rate 1008 ms
Class ID : ©x0901
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7.3 LDSBus DO Sensor Adapter Calibration

To calibrate DO Sensor Adapter, follow these steps =

1. Click [Calibrate] from the LDSU / LDSBus Project interface to start the calibration.

LDSBus Configuration Utility-LDSU Project

File | LDSU Commands Firmware Update Settings About

LDSU Port Power

St On ¥ Enable

LDSU

uuID
LDSU ID -
7844106E6

Serial Number
LDSU Termination >
LDSBus DO Sensor

Product Name
roduc ame e LDSBus DO Sensor

LDSU Class 0x800C
Update

Manufacture Date L=

Calibrated Current (mA) 48

Calibrated Voltage (mV)

Calibrated Temperature (°C) =

Calibrated Date e i
E Calibrate
Number of I2C Devices

Software Version

I2C Devices

Manufacturer : Bridgetek Pte
PartNumber : BRT-VDEV
Address : 0x8@

Capability : @

Report Rate 1008 ms

Class ID : ©x@902

2. An information window prompting the users for Power Selection is displayed. If you want to
continue calibration with USB Adaptor 5V, just select "USB Adaptor 5V” option. But if you want
to switch to T-Junction to calibrate your sensor, just select “T-Junction 24V"” option, we strongly
recommend user to use T-Junction for sensor calibration to achieve better accuracy. After
selecting power selection, click [OK] to continue or click [Cancel] to cancel the calibration
process.

Calibration Power Selection
Power Selection
@® USB Adaptor 5V O T-Junction 24V

Attach LDSBus Sensor Adaptor to the LDSBus USB
Adaptor RJ11 port.

[0]3 ‘ Cancel

Cancel

3. If "USB Adaptor 5V” selected, a confirmation window will pop up to confirm user connect the
sensor to the USB Adaptor RJ11 port. click [OK] to continue or click [Cancel] to cancel the
calibration process.
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If “T-Junction 24V" selected. LDSU Calibration requires 24V Power supply. Remove the sensor
module and attach to the HVT-Junction connected to the LDSBus Port. Click [Ok] to continue or
[Cancel] to quit the calibration process.

Calibration requires 24V LDSBus Power.
Remove and attach Sensor adapter to a LDSBus HVT-

Junction connected to the LDSBus Port.

‘ Cancel

Upon clicking [Ok], a confirmation window prompting the user to switch from LDSU Port Power
to LDSBus Port Power is displayed. Click [Ok] to switch. Alternately, click [Cancel] to exit the

calibration process. Upon clicking [OK], the project window will be in disabled mode and the
countdown timer starts.

Switch from LDSU Port Power
to LDSBus Port Power?

4. Upon successful power switch, system will prompt the users to start the calibration. Click [Ok].
Using pure water, wet the probe and click on the checkbox accordingly.

DO Sensor Calibration DO Sensor Calibration

Temperature Temperature

Wet the probe in pure water Wet the probe in pure water

Shake off excess water drops

Cancel Cancel

5. After shaking off excess water, click the check box.

6. Make sure the probe is exposed to the air, then click the check box.

DO Sensor Calibration

Temperature

Wet the probe in pure water

Shake off excess water drops

Expose the probe to the air
Maintain proper air flow
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7. Upon successful calibration, an appropriate message indicating the same is displayed. Click [Ok]
to continue. The calibration result will be displayed. Click [Verify] to verify the calibration data
or click [Cancel] to cancel the calibration.
DO Sensor Calibration Verification

Temperature

Current reading:
Wet the probe in pure water ] 8.25 mg/L

Shake off excess water drops

Expose the probe to the air

Maintain proper air flow

. N . Decline
Sensor Calibration

Verify

8. The verification window will display the current reading. Click [Accept] if the current reading is
with reasonable range, click [Decline] if current reading is not acceptable and you can
recalibrate the device again.

9. Click [Update] to flash the calibration data into the device.

DO Sensor Calibration

Temperature

Wet the probe in pure water
Turning off LDSBus Port Power
Shake off excess water drops =

Expose the probe to the air
Maintain proper air flow

Sensor Calibration

Update Cancel

10. Upon successful update, an appropriate message indicating the same is displayed. The LDSBus
Power will be switched off.

11. Connect the sensor back to the USB adapter after removing it from the HVT junction, and then
click [Ok]. For power switching, wait 60 seconds.

Detach LDSBus Sensor Adapter from the LDSBus HWVT-
Junction

and attach to the LDSBus USB Adapter RJ11 port.
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12. In the main window, the calibration date will be updated after the utility scans the device again.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands

LDSU Port Power

LDSU
uuID

Serial Number

Product Name

LDSU Class

Manufacture Date
Calibrated Current (mA)
Calibrated Voltage (mV)
Calibrated Temperature (°C)
Calibrated Date

Number of I2C Devices

Software Version

I12C Devices

Firmware Update

Settings

Enable

L510018101042200851

7844106E6

LDSBus DO Sensor
x880C

2022-Jun-04

40

Manufacturer : Bridgetek Pte Ltd.

PartNumber : BRT-VDEV
Addre 00
Capability

Report Rat

Class ID

About

LDSU ID

LDSU Termination
Nickname

Update

Calibrate

7.4 LDSBus ORP Sensor Adapter Calibration

To calibrate ORP Sensor Adapter, follow these steps —

1. Make one beaker of pure water and connect an ORP sensor to a USB adapter.

2. To scan the ORP sensor, click [Scan], if the sensor has not been calibrated, an alert will appear

asking whether to calibrate. Click [Yes] to start the calibration process.

Device is Not Calibrated, Start Calibration Now?

Clicking [No] will display the same calibration data screen as the sensor. Click [Calibrate] to

start the calibration.

LDSBus DO Sensor
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LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

LDSU P Power

On ¥ Enable

LDSU
uuID S 8172200002
LDSU ID ~

Serial Number
LDSU Termination off ~

Product Name
roduc ame Nickname LDSBus ORP Sensor

LDSU Class
Update

Manufacture Date
Calibrated Current (mA)
Calibrated Voltage (mV)
Calibrated Temperature (°C)
Calibrated Date
Calibrate

Number of I2C Devices

Software Version

I2C Devices

Manufacturer : BridgeTek Pte Ltd.
PartNumber : BRT-VDEV

Address : ©0x00

Capability : @

Report Ra 1080 ms

Cla ] a5

An information window prompting the users for Power Selection is displayed. If you want to
continue calibration with USB Adaptor 5V, just select "USB Adaptor 5V” option. But if you want
to switch to T-Junction to calibrate your sensor, just select “T-Junction 24V"” option, we strongly
recommend user to use T-Junction for sensor calibration to achieve better accuracy. After
selecting power selection, click [OK] to continue or click [Cancel] to cancel the calibration
process.

Calibration Power Selection

Power Selection

® USB Adaptor 5V O T-Junction 24V
Attach LDSBus Sensor Adaptor to the LDSBus USB
Adaptor RJ11 port.

0Ok Cancel

Cancel

If "USB Adaptor 5V” selected, a confirmation window will pop up to confirm user connect the
sensor to the USB Adaptor RJ11 port. click [OK] to continue or click [Cancel] to cancel the
calibration process.

If “T-Junction 24V” selected. LDSU Calibration requires 24V Power supply. Remove the sensor
module and attach to the HVT-Junction connected to the LDSBus Port. Click [Ok] to continue or
[Cancel] to quit the calibration process.

Calibration requires 24V LDSBus Power.
Remove and attach Sensor adapter to a LDSBus HVT-

Junction connected to the LDSBus Port.

Cancel
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Upon clicking [Ok], a confirmation window prompting the user to switch from LDSU Port Power
to LDSBus Port Power is displayed. Click [Ok] to switch. Alternately, click [Cancel] to exit the

calibration process. Upon clicking [OK], the project window will be in disabled mode and the
countdown timer starts.

Switch from LDSU Port Power
to LDSBus Port Power?

Cancel

Upon successful power switch, system will prompt the users to start the calibration. Click [Ok].
Calibration interface for ORP Sensor is displayed. Enter the correct calibration temperature and
buffer solution. Prepare the ORP buffer solution and click on the checkbox accordingly.

ORP Sensor Calibration ORP Sensor Calibration

Temperature Temperature

Buffer Solution (mV)

Prepare ORP buffer solution and Enter detail above E

Buffer Solution (mV)

Prepare ORP buffer solution and Enter detail above

Seperate solution to two beakers: beaker 1 and 2 E

Cancel

Separate buffer solutions into two beakers, beaker 1 and beaker 2 and click on the checkbox
accordingly.

Remove the probe from its storage solution, rinse with distilled water, and blot dry with Kimwipes
or Shurwipes. Upon doing so, click the check box.

ORP Sensor Calibration ORP Sensor Calibration

Temperature Temperature

Buffer Solution (mV) Buffer Solution (mV)

Prepare ORP buffer solution and Enter detail above Prepare ORP buffer solution and Enter detail above

Seperate solution to two beakers: beaker 1 and 2 Seperate solution to two beakers: beaker 1 and 2

Take probe out of storage solution

Take probe out of storage solution
Rinse with distilled water

Rinse with distilled water
Blot dry with Kimwipes or Shurwipes

Blot dry with Kimwipes or Shurwipes

Rinse probe in beaker 1 solution

Cancel

Cancel

8. Rinse the probe with solution from beaker 1 and click on the check box.
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9. Calibrate the probe by putting it in beaker 2 solution and click on the check box.

ORP Sensor Calibration

Temperature

Buffer Solution (mV)

Prepare ORP buffer solution and Enter detail above
Seperate solution to two beakers: beaker 1 and 2

Take probe out of storage solution
Rinse with distilled water
Blot dry with Kimwipes or Shurwipes

Calibration value accepted.

Rinse probe in beaker 1 solution

Put probe in beaker 2 solution for calibration

Cancel

10. Upon successful calibration, an appropriate message indicating the same is displayed. Click [Ok]
to continue.

11. The calibration result will be displayed. Click [Verify] to verify the calibration data or click
[Cancel] to cancel the calibration.

ORP Sensor Calibration

Temperature 25.0 Verification
Buffer Solution (mv)

Prepare ORP buffer solution and Enter detail above

Seperate solution to two beakers: beaker 1 and 2 Current read il’]g' 225.00 mV
Take probe out of storage solution

Rinse with distilled water

Blot dry with Kimwipes or Shurwipes

Rinse probe in beaker 1 solution Agcept Decline

Put probe in beaker 2 solution for calibration

Sensor Calibration Result

Verify Cancel

12. The verification window will display the current reading. Click [Accept] if the current reading is
with reasonable range, click [Decline] if current reading is not acceptable and you can
recalibrate the device again.

13. Click [Update] to flash the calibration data into the device.

ORP Sensor Calibration

Temperature

Buffer Solution (mv)

Prepare ORP buffer solution and Enter detail above

Seperate solution to two beakers: beaker 1 and 2

Take probe out of storage solution
Rinse with distilled water
Blot dry with Kimwipes or Shurwipes

Rinse probe in beaker 1 solution

Put probe in beaker 2 solution for calibration

Sensor Calibration Result

Update Cancel
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14. Upon successful update, an appropriate message indicating the same is displayed. LDSBus Power
will be switched off.

Turning off LDSBus Port Power Detach LDSBus Sensor Adapter from the LDSBus HVT-

Junction

and attach to the LDSBus USB Adapter RJ11 port.

15. Connect the sensor back to the USB adapter after removing it from the HVT junction, and then
click [Ok]. For power switching, wait 60 seconds.
16. In the main window, the calibration date will be updated after the utility scans the device again.
LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

4 Enable

L510019101042200051
LDSU ID >
784406E6

Serial Number
LDSU Termination >

Nickname LDSBus DO Sensor

Update

Product Name LDSBus DO Sensor
LDSU Class

Manufacture Date 202 ©
Calibrated Current (mA) 0

Calibrated Voltage (mV)

Calibrated Temperature (°C)

Calibrated Date 2022-Dec-13

1 Calibrate

Number of I2C Devices

Software Version 2.2

I2C Devices

Manufacturer : Bridgetek Pte
PartNumber : BRT-VDEV
Address : @xee

Capability : @

Report Rate 1888 ms

Class ID : @x@902
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7.5 LDSBus CO2 Sensor Adapter Calibration

To calibrate CO2 Sensor Adapter, follow these steps -

1. Prepare the reference CO2 meter and connect it to the USB adapter to achieve better accuracy.
Make sure that the reading of the environment CO2 is greater than 400ppm. To scan the CO2
sensor, click [Scan], if the sensor has not been calibrated, an alert will appear asking whether
to calibrate. Click [Yes] to start the calibration process.

Device is Not Calibry; Start Calibration MNow?

Clicking [No] will display the same calibration data screen as the sensor. Click [Calibrate] to
start the calibration.

LDSBus Configuration Utility-1DSU Project

File LDSU Commands Firmware Update Settings About

HELI

L511010149252200822
LDSU ID >

Serial Number
LDSU Termination ~
Product Name LDSBus C02 Sensor
rodue ame Nickname LDSBus CO2 Sensor
LDSU ox8011
Update

Manufacture Date Lidlan=is

Calibrated Current (mA)

Calibrated Voltage (mV)

Calibrated Temperature (°C)

Calibrated Date

Calibrate
Number of I2C Devices

Software Version

I12C Devices

Manufacturer : BRT Systems Pte Ltd. Manufacturer : ROHM Semiconductor Manufacturer : Sensirion Manufacturer : Sensirion
BRT-VDEV PartNumber : BH1738FVC PartNumber : PartNumber : SCD40
Address : 8x29 Address : © Address
Capability : @ Capability : ° Capability : 1
Report Rate 1608 ms Report Rate : 1880 ms Report Rate 5000 ms Report Rate : 5880 ms
Class ID 04 Class ID : 9xe4e1 Class ID : Class ID : 9x0180
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An information window prompting the users for Power Selection is displayed. If you want to
continue calibration with USB Adaptor 5V, just select "USB Adaptor 5V” option. But if you want
to switch to T-Junction to calibrate your sensor, just select “T-Junction 24V” option, we strongly
recommend user to use T-Junction for sensor calibration to achieve better accuracy. After
selecting your power selection, click [OK] to continue or click [Cancel] to cancel the calibration
process.

Calibration Power Selection

Power Selection

® USB Adaptor 5V O T-Junction 24V

Ok ‘ Cancel

3. If “USB Adaptor 5V” selected, a confirmation window will pop up to confirm user connect the
sensor to the USB Adaptor RJ11 port. click [OK] to continue or click [Cancel] to cancel the
calibration process.

Attach LDSBus Sensor Adaptor to the LDSBus USB
Adaptor RJ11 port.

Calibration requires 24V LDS5Bus Power.
Remove and attach Sensor adapter to a LDSBus HVT-
Junction connected to the LDSBus Port.

Cancel

If “T-Junction 24V” selected. LDSU Calibration requires 24V Power supply. Remove the sensor
module and attach to the HVT-Junction connected to the LDSBus Port. Click [Ok] to continue or
[Cancel] to quit the calibration process.

Upon clicking [Ok], a confirmation window prompting the user to switch from LDSU Port Power
to LDSBus Port Power is displayed. Click [Ok] to switch. Alternately, click [Cancel] to exit the
calibration process. Upon clicking [OK], the project window will be in disabled mode and the
countdown timer starts.

Switch from LDSU Port Power
to LDSBus Port Power?

. Cancel

4. Upon successful power switch, system will prompt the users to start the calibration. Click [Ok].
Wait for 180 seconds for CO2 reading to stabilize.

Start Calibration
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5. The calibration result will be displayed. Enter the CO2 reading from CO2 reference meter. Click
[Verify] to verify the calibration data or click [Cancel] to cancel the calibration.

SCD4X (02 Sensor Force Recalibration Verification
Send start_periodic_measurement command

Wait for 3 minutes

Current reading:
Send stop periodic measurement command ™ 400 ppm

Reference Meter Reading

Cancel

6. The verification window will display the current reading. Click [Accept] if the current reading is
with reasonable range, click [Decline] if current reading is not acceptable and you can
recalibrate the device again.

7.

Click [Update] to flash the calibration data into the device or click [Cancel] to avoid save
calibration data.

SCDAX €02 Sensor Force Recalibration
Send start_periodic_measurement command
Wait for 3 minutes

Send stop_periodic_measurement command Turning off LDSBus Port Power

Reference C02 Meter Reading

8. Upon successful update, an appropriate message indicating the same is displayed. LDSBus Power
will be switched off.
9. Connect the sensor back to the USB adapter after removing it from the HVT junction, and then
click [Ok]. For power switching, wait 60 seconds.
Detach LDSBus Sensor Adapter from the LDSBus HVT-
Junction
and attach to the LDSBus USB Adapter RJ11 port.
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10. In the main window, the calibration date will be updated after the utility scans the device again.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

LDSU Port Power

Sta On Enable

LDSU

uuID
LDSU ID -

Serial Number
LDSU Termination -

Product Name
roduc ame ke LDSBus C02 Sensor

LDSU Class
Update
Manufacture Date
Calibrated Current (mA)
Calibrated Voltage (mV)

Calibrated Temperature

Calibrated Date

Calibrate
S ————

Software Version

I12C Devices

Manufacturer : BRT Systems Pte . Manufacturer : ROHM Semiconductor Manufacturer : Sensirion Manufacturer : Sensirion
PartNumber BRT-VDEV PartNumber : BH1738FVC PartNumber SCD40 PartNumber SCD40
Address : @x@0 Address : @x29 8 Address 62
Capability e Capability : @ ility Capability : 1

Report Rate % Report Rate : 1000 ms r 5000 ms Report Rate 000 ms
Class ID : @x Class ID : Bx0401 E : Ox08304 Class ID : Bx0108

7.6 LDSBus Honde 2inl1 Soil Sensor Calibration

To calibrate Honde 2in1 Soil Sensor, follow these steps —
1. Connect Honde 2in1 Soil Sensor to the USB adaptor. To scan the Honde 2inl Soil Sensor, click

[Scan], if the sensor has not been calibrated, an alert will appear asking whether to calibrate.
Click [Yes] to start the calibration process.

Device is Mot Calibrated, Start Calibration Now?

Clicking [No] will display the same calibration data screen as the sensor. Click [Calibrate] to
start the calibration.
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LDSBus Configuration Utility-LDSU Project
File LDSU Commands Firmware Update Settings

LDSU Port Power

st : On Enable
LDSU

uuID LA1401010881224008001
LDSU ID -

Serial Number -

LDSU Termination
- LDSBus Modbus/SDI-12 Adapter
Product Name / P
roduc ame Nickname LDSBus Honde 2inl Seil Senso
LDSU Class D
Update

Manufacture Date 2024-Aug-12

Calibrated Current (mA) 8e

Calibrated Voltage (mv) 5180
Calibrated Temperature (°C) 25

Calibrated Date 2024-Aug-12

5 Calibrate
Number of I2C Devices =
— Sensor Configuration
Software Version e

I2C Devices

Manufacturer : BRT Systems Pte Ltd. Manufacturer : Microchip Technology Inc
PartNumber : BRT-VDEV PartNumber : MCP48D17T
Addres Z Address
Capability : @ Capability
@ ms

2. An information window prompting the users for Power Selection is displayed. If you want to
continue calibration with USB Adaptor 5V, just select "USB Adaptor 5V” option. But if you want
to switch to T-Junction to calibrate your sensor, just select “T-Junction 24V"” option, we strongly
recommend user to use T-Junction for sensor calibration to achieve better accuracy. After
selecting your power selection, click [OK] to continue or click [Cancel] to cancel the calibration
process.

Calibration Power Selection

Power Selection

@® UsB Adaptor' 5V O T-Junction 24V Attach LDSBus Sensor Adaptor to the LDSBus USB

Adaptor RJ11 port.

Ok Cancel

Cancel

3. If "USB Adaptor 5V” selected, a confirmation window will pop up to confirm user connect the
sensor to the USB Adaptor RJ11 port. click [OK] to continue or click [Cancel] to cancel the
calibration process.

If “T-Junction 24V” selected. LDSU Calibration requires 24V Power supply. Remove the sensor
module and attach to the HVT-Junction connected to the LDSBus Port. Click [Ok] to continue or
[Cancel] to quit the calibration process.

Calibration requires 24V LDSBus Power.
Remove and attach Sensor adapter to a LDSBus HVT-

Junction connected to the LDSBus Port.

Cancel
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Upon clicking [Ok], a confirmation window prompting the user to switch from LDSU Port Power
to LDSBus Port Power is displayed. Click [Ok] to switch. Alternately, click [Cancel] to exit the
calibration process. Upon clicking [OK], the project window will be in disabled mode and the
countdown timer starts.

Switch from LDSU Port Power
to LDSBus Port Power?

’ Cancel

4. Upon successful power switch, system will prompt the users to start the calibration. Click [Ok]
to start calibration.

Start Calibration

First Point Calibration

5. The interface for the First point calibration for 4.01pH is displayed. Prepare Buffer solution
(4.01pH). There should be two sets of beakers for each solution. Beaker 1 is the clean water
which is used to clean the probe before a calibration and Beaker 2 is used for the actual
calibration measurement. Upon preparing the solutions, click on the Beaker-2 for Calibration
4.01pH checkbox.

pH - First point calibration - 4.01pH pH - First point calibration - 4.01pH

Prepare solutions in 2 beakers
> Beaker-1: Clean water for probe cleaning
> Beaker-2: Buffer for calibration 4.81pH

Prepare solutions in 2 beakers
> Beaker-1: Clean water for probe cleaning
> Beaker-2: Buffer for calibration 4.@1pH

Rinse the probe in beaker-1

6. Remove the electrode from its storage solution and rinse it with distilled water in an empty waste
beaker. Upon rinsing the probe with distilled water, click on the Rinse the probe in beaker-1
check box.
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7. After rinsing, wipe dry with Kimwipes or Shurwipes and click on the Dry the probe with Kimwipes
or Shurwipes checkbox. (Avoid rubbing the electrode because it has a sensitive membrane).

pH - First point calibration - 4.81pH pH - First point calibration - 4.@1pH

Prepare solutions in 2 beakers Prepare solutions in 2 beakers
> Beaker-1: Clean water for probe cleaning > Beaker-1: Clean water for probe cleaning
> Beaker-2: Buffer for calibration 4.01pH > Beaker-2: Buffer for calibration 4.@1pH

Rinse the probe in beaker-1 Rinse the probe in beaker-1
Dry the probe with Kimwipes or Shurwipes n Dry the probe with Kimwipes or Shurwipes

Immerse the probe fully into beaker-2
without touching beaker

8. Immerse the probe into Beaker 2 (4.01pH) to start the calibration. then click Immerse the probe
fully into beaker-2 without touching beaker checkbox.

9. An information window will appear. Click [Ok] to proceed. The calibration window will be in
disabled mode and the countdown timer starts as shown in the picture. Wait for 60 seconds to
stabilize the readings.

pH - First point calibration - 4.@1pH

Prepare solutions in 2 beakers
> Beaker-1: Clean water for probe cleaning
> Beaker-2: Buffer for calibration 4.81pH

Rinse the probe in beaker-1
Confirm to start calibration, it will take 68

N Dry the probe with Kimwipes or Shurwipes
seconds?

Immerse the probe fully into beaker-2
without touching beaker

4.01pH calibration result: 4.00

Retry

10. Check the result. If the first point calibration is unsuccessful, an error message is displayed.
Click [Retry] to start the first point calibration again (Repeat Steps 5 - 10 until the first point
calibration is successful). Upon successful calibration, The Calibration result will be displayed.
Click [Next] to proceed with the Second point calibration.

Second Point Calibration

11. Upon successfully completing the First Point Calibration, the Second Point Calibration interface
is displayed. Prepare Second buffer solution. There should be two sets of beakers for each
solution. Beaker 1 is clean water which is used to clean the probe before a calibration and Beaker
2 is used for the actual calibration measurement. Upon preparing the solutions, click on the
Beaker-2 for Calibration 6.86pH checkbox.

pH - Second point calibration - 6.86pH pH - Second point calibration - 6.86pH

Prepare solutions in 2 beakers
> Beaker-1: Clean water for probe cleaning
> Beaker-2: Buffer for calibration 6.86pH

Prepare solutions in 2 beakers
> Beaker-1: Clean water for probe cleaning
> Beaker-2: Buffer for calibration 6.86pH

Rinse the probe in beaker-1

12. Remove the electrode from its storage solution and rinse it with distilled water in an empty waste
beaker. Upon rinsing the probe with distilled water, click on the Rinse the probe in beaker-1
check box.
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13. After rinsing, wipe dry with Kimwipes or Shurwipes and click on the Dry the probe with Kimwipes
or Shurwipes checkbox.

pH - Second point calibration - 6.86pH

pH - Second point calibration - 6.86pH

Prepare solutions in 2 beakers
> Beaker-1: Clean water for probe cleaning
> Beaker-2: Buffer for calibration 6.86pH

Prepare solutions in 2 beakers
> Beaker-1: Clean water for probe cleaning
> Beaker-2: Buffer for calibration 6.86pH

Rinse the probe in beaker-1 Rinse the probe in beaker-1

Dry the probe with Kimwipes or Shurwipes

Dry the probe with Kimwipes or Shurwipes

Immerse the probe fully into beaker-2
without touching beaker

14. Immerse the probe into Beaker 2 (6.86pH) to start the calibration. then click Immerse the probe
fully into beaker-2 without touching beaker checkbox.

15. An information window will appear. Click [Ok] to proceed. The calibration window will be in
disabled mode and the countdown timer starts as shown in the picture. Wait for 60 seconds to
stabilize the readings.

Confirm to start calibration, it will take &8
seconds?

16. Check the result. If the second point calibration is unsuccessful, an error message is displayed.
Click [Retry] to start the second point calibration again (Repeat Steps 12 - 16 until the second
point calibration is successful). Upon successful calibration, The Calibration result will be
displayed. Click [Next] to proceed with the Third point calibration.

pH - Second point calibration - 6.86pH

Prepare solutions in 2 beakers
> Beaker-1: Clean water for probe cleaning
> Beaker-2: Buffer for calibration 6.86pH

Rinse the probe in beaker-1

Dry the probe with Kimwipes or Shurwipes

Immerse the probe fully into beaker-2
without touching beaker

6.86pH calibration result: 6.90

Back Retry
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Third Point Calibration

17. Upon successfully completing the Second Point Calibration, the Third Point Calibration interface
is displayed. Prepare Second buffer solution. There should be two sets of beakers for each
solution. Beaker 1 is clean water which is used to clean the probe before a calibration and Beaker
2 is used for the actual calibration measurement. Upon preparing the solutions, click on the
Beaker-2 for Calibration 9.18pH checkbox.

pH - Third point calibration - 9.18pH pH - Third point calibration - 9.18pH

Prepare solutions in 2 beakers Prepare solutions in 2 beakers
> Beaker-1: Clean water for probe cleaning > Beaker-1: Clean water for probe cleaning
> Beaker-2: Buffer for calibration 9.18pH > Beaker-2: Buffer for calibration 9.18pH

Rinse the probe in beaker-1

18. Remove the electrode from its storage solution and rinse it with distilled water in an empty waste
beaker. Upon rinsing the probe with distilled water, click on the Rinse the probe in beaker-1
check box.

19. After rinsing, wipe dry with Kimwipes or Shurwipes and click on the Dry the probe with Kimwipes
or Shurwipes checkbox.

pH - Third point calibration - 9.18pH pH - Third point calibration - 9.18pH

Prepare solutions in 2 beakers Prepare solutions in 2 beakers
Clean water for probe cleaning > Beaker-1: Clean water for probe cleaning
> Beaker-2: Buffer for calibration 9.18pH > Beaker-2: Buffer for calibration 9.18pH

Rinse the probe in beaker-1 Rinse the probe in beaker-1
Dry the probe with Kimwipes or Shurwipes ] Dry the probe with Kimwipes or Shurwipes

Immerse the probe fully into beaker-2
without touching beaker

20. Immerse the probe into Beaker 2 (9.18pH) to start the calibration. then click Immerse the probe
fully into beaker-2 without touching beaker checkbox.

21. An information window will appear. Click [Ok] to proceed. The calibration window will be in
disabled mode and the countdown timer starts as shown in the picture. Wait for 60 seconds to
stabilize the readings.

Confirm to start calibration, it will take 60
seconds?
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22. Check the result. If the third point calibration is unsuccessful, an error message is displayed.
Click [Retry] to start the third point calibration again (Repeat Steps 18 — 22 until the third point
calibration is successful). Upon successful calibration, The Calibration result will be displayed.
Click [Verify] to proceed with calibration verification.

pH - Third point calibration - 9.18pH Verification

in 2 beakers

1 Clean water fo

: Buffer for calibration 9.18p ] Current rpading:
Rinse the probe in beaker-1 = 9.25 pH
Dry the probe with Kimwipes or Shurwipes

Immerse the probe fully into beaker-2

without touching beaker _
9.18pH calibration result: 9.25 i »

Back Retry

23. The verification window will display the current reading. Click [Accept] if the current reading is
with reasonable range, click [Decline] if current reading is not acceptable and you can
recalibrate the device again.

24. Click [Update] to flash the calibration data into the device.

pH - Third point calibration - 9.18pH

Prepare solutions in 2 beakers
> Beaker-1: Clean water for probe cleaning
> Beaker-2: Buffer for calibration 9.18pH

Rinse the probe in beaker-1 Turning off LDSBus Port Power
Dry the probe with Kimwipes or Shurwipes

Immerse the probe fully into beaker-2
without touching beaker

9.18pH calibration result: 9.25

Back Retry

25. Upon successful update, an appropriate message indicating the same is displayed. LDSBus Power
will be switched off.

26. Connect the sensor back to the USB adapter after removing it from the HVT junction, and then
click [Ok]. For power switching, wait 60 seconds.

Detach LDSBus Sensor Adapter from the LDSBus HVT-
Junction

and attach to the LDSBus USB Adapter RJ11 port.
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27. In the main window, the calibration date will be updated after the utility scans the device again.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update

LDSU Port Power
¥ Enable

LA1491010812240
LDsU ID

o eel

. LDSBus Modbus/SDI-12 Adapter ; )
: t Ne
FFEdlozs: [ A rEE LDSBus Honde 2inl Soil Senso

LDSU Class 801D
Update

Manufacture Date 2624-Aug-12

Calibrated Current (mA)
Calibrated Voltage (m
Calibrated Temperature (
Calibrated Date

. Calibrate
Number of I2C Devices

Sensor Configuration
Software Version

2C Devices

actur : BRT Systems Pte Ltd. Mz act Microchip Technology Inc
umb BRT-VDEV E: e A40D17T
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8 Application Type Configuration

8.1 Relay Controller Application Type Configuration

To configure application type for Relay Controller -

1. Click [Application Type Configuration].

LDSBus Configuration Utility-LDSU Project

File LDSU

Serial Mumber

Product

Calibrat
Calibratec
Calibratec
Calibrated Date
Number of I2C

Software Version

I2C Devices

Manufacturer :
PartNumber
Address 00
Capability 2]
Report Rate :

Class ID : ©x@BOO

2. The Relay Controller Application Type configuration window is displayed.

Relay Board Application Type Configuration

LDSU
UUID

Product Mame

Relay Setting

Relay 1:

Commands

Bridgetek Pte Ltd.
BRT-VDEV

1068 ms

Firmware Update

B Enable

LCO1110101042200090
58D365A5

LDSBus 2CH Relay
Bx4001

20823-Jan-30

64

50800

65

Not Applicable

Manufacturer :
PartNumber
Address
Capability
Report Rate
Class ID :

LCP11101818422¢

LDSBus 2CH Relay

4 Wire Motor v

Settings

LDSU ID

LDSU Termination
Nickname

Update

LDSBus 2CH Relay

Application Type Configuration

Bridgetek Pte Ltd.
2CH Relay

LDSU ID 13

LDSU Termination [Off

Relay 2:

4 Wire Motor
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3. Select the setting for each relay from the drop-down box. There are different input windows for
the different relay settings. For example, for 4 wire motor, the setting input will look like the one
shown in the picture.

a. The settings shown in the 4-wire Motor Setting, indicate that the motor is powered via
the COM-NO contacts of Relay 1, i.e., when Relay 1’s contacts are in COM-NC, the power
is OFF.

b. Similarly, when Relay 2's COM-NO contacts are closed, the motor is driven in the forward
(FWD) direction and when COM-NC contacts are closed, the motor is driven in the
reverse (REV) direction. The user shall determine the forward and reverse directions of
the motor.

Relay Board Application Type Configuration
LDSU
UUID LCO1116181042208098 LDSU ID 13

Product Name |LDSBus 2CH Relay LDSU Termination Off

Relay Setting

Relay 1: 4 Wire Motor Relay 2: 4 Wire Motor

None
Generic DOUT
4 Wire Motor

Update

4-Wire Motor Setting
Settings

Relay 1: Power

|||| ||||

Relay 2: Direction
Power: 'II')

Direction: NO = FWD, NC = REV ~

=
=]
Il

ON, NC = OFF ~

Timer: Not timed
Time onoff (secs): 65535

Grd Time OnOff (secs):

Grd Time OffOn (secs):

B Set Application Reference?
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4. Once all relays are configured, click [Update] to save the settings to the device’s EEPROM. A
confirmation window will be displayed whether to update the application. Click [Yes] to update;
[No] to cancel the update. Upon successful update, an appropriate message indicating the same
will be displayed.

Confirm Application Update? Application Data Update Successful!

8.2 I0 Controller Application Type Configuration
To configure application type for IO Controller Module -

1. Click [Application Type Configuration].

LDSBus Configuration Utility-LDSU Project
File LDSU Commands Firmware Update Settings About

LDSU Port Power
S ELAT
LDSU

uuID LCB66168101842200852
LDSU ID >

Serial Number DBBAB9IBE

LDSU Termination v

= LDSBus Isolated IO Controller
t Name

Areinee (e Nickname LDSBus Isolated T0 Controlle

5T Eleee excee1

Manufacture Date 2

Calibrated Current (mA) 240

Calibrated Voltage (

Calibrated Temperature EY

Calibrated Date Not Applicable

Number of I2C Devices E

Software Version 20

Application Type Configuration

r : Bridgetek Pte Ltd. Manufacturer : Bridgetek Pte Ltd. Manufacturer : Bridgetek Pte Ltd.
PartNumbe RT-VDEV PartNumbe T0-CONTROLLER PartNumber ATO-CONTROLLER
Address Address Address X
Capabil Capabil Capability : @
Report Rate 08 ms Report Rate 00 ms Report Rate 10080 ms
Class ID : ©xCeel Class ID : ©x0Ce0 Class ID : Ox@BFF

2. A window will appear asking for a new configuration if the IO controller board was configured
previously. Click [Yes] to change the setting; [No] to not change the setting.

Application Already Configured For This Device, Do
You Want To Configure Again?
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Alternatively, if the I0 controller has not been configured previously, this window will not appear.

Click [Yes] to configure the IO controller application type. If no configuration is done on the board,
the following window will appear.

I0 Controller Application Type Configuration
LDSU
UUTD LCP6810101042260097 LDSU ID 97

Product MName LDSBus Isolated I0 Controller LDSU Termination OFf

Output
Generic AIN LUV Generic AOUT

None AQUTZ2: [l
Generic DIN [POVINEN Generic DOUT

None DOUT2: [l

Number of Bytes Left: 104

Update

In total, there are 8 channels that can be configured. Below is a list of the input definitions of all
channels.

AIN1 - Analog input channel 1
AIN2 - Analog input channel 2
DIN1 - Digital input channel 1
DIN2 - Digital input channel 2
AOUT1 - Analog output channel 1
e AOUT2 - Analog output channel 2
DOUT1 - Digital output channel 1
e DOUT2 - Digital output channel 2

AIN 1 & AIN 2 Channels

Both AIN1 and AIN2 have the same drop-down options -

I0 Controller Application Type Configuration
LDSU
UUID LCA6016101042200093 LDSU ID

Product Name LDSBus Isolated IO Controlley LDSU Termination [Off

Output

Generic AIN AQUTL:

None )
Generic AIN AOUT2:

DOUT1:

Hot Wire Wind Speed
None DOUT2:

Number of Bytes Left: 119

Update

None - Not Configured

Generic AIN - General Analog input configuration

Water Level — To configure water level sensor

Wind Vane - To configure Wind Vane

Hot Wire Wind Speed - To configure Hot Wire wind speed connection
Water Level Sensor / Wind Vane Sensor

O O O O O
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» Upon selecting Water Level / Wind Vane option, the respective configuration
interface is displayed.

Water Level Sensor Wind Wane Sensor

Settings .
erngs Settings

Max VDD(V):

Step:

Min Depth ADC (@~1823): 16 ADC Data (0-1023):

Max Depth ADC (@~1823): Separate each data
) point with new line
Min Depth Millivolt(mV}):
Input Data
Max Depth Millivolt(mv): From CSV

Max Depth(m): 16 Data

Offset Millivolt(mv):

Set Data Set Data

» Change the settings as required. For Wind Wane Sensor, to input 16 ADC data
points, choose 0:22.5deg and enter the information either line-by-line or using
a .csv file. Otherwise, if 1:45.0deg is selected, then 8 ADC data points is required
as input.

» Upon changing the settings (if any), click [Set Data] to save the settings.

Hot Wire Wind Speed

> Upon selecting Hot Wire Wind Speed option, the respective configuration
interface is displayed.

Wind Speed HW Sensor
Settings

B Temperature Sensor?

Zero Wind ADC (0~1023):

Min Speed (KM/H):

Max Speed (KM/H):

@ Deg ADC Value:

» Change the settings as required. Wind speed hot wire sensor may use both
analog input channel. One channel for wind speed and another channel for
temperature. If you check “Temperature Sensor” checkbox, this channel will be
use as wind speed configuration and another channel will be use as temperature
sensor configuration, please connect the hardware accordingly.

» Upon changing the settings (if any), click [Set Data] to save the settings.
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Both DIN1 and DIN2 have the same drop-down options -

I0 Controller Application Type Configuration
LDSU
UUID LCO68101681642200899 LDSU ID

Product Mame LDSBus Isolated I0 Controller LDSU Termination Off

Output
AOUTL:

AQUT2:
DOUT1:
DouT2:
Wind Speed Cup Anemometer

Rain Gauge

! r of Bytes Left: 124
Switch

Update

None - Not Configured

Generic DIN - General Digital input configuration

Wind Speed Cup Anemometer — To configure Wind Speed Cup Anemometer
Rain Gauge - To configure Rain gauge

Switch - To configure Switch

O O O O O

Wind Speed Cup Anemometer

» Upon selecting Wind Speed Cup Anemometer option, the respective
configuration interface is displayed.

Wind Speed Cup Sensor
Settings

wind speed (m/s) expressed as

a scaled integer, e.g. 667

exponent, actual rate = rate*10~(-exp),
e.g. exp=3, actual rate=0.667 m/s,

per count

Rate: 667

Exponent:

S5et Data

» Upon changing the settings (if any), click [Set Data] to save the settings.
» As Wind Speed Cup Anemometer option request IO controller with actuator
firmware, if IO controller is not programmed with actuator firmware, firmware

update window will prompt up after click [Update] to save the settings to
EEPROM.
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Rain Gauge

» Upon selecting Rain Gauge option, the respective configuration interface is
displayed.

Rain Gauge Sensor

Settings

mm rainfall, expressed as

a scaled integer, e.g. 2794

exponent, actual rate = rate * 10~(-exp),
e.g. exp=4;

actual rate = ©.2794 mm per count

Rate: 2794
Exponent: _ ‘

Set Data

» Upon changing the settings (if any), click [Set Data] to save the settings.

> As Rain Gauge option request 10 controller with counter firmware, if I0 controller
is not programmed with counter firmware, firmware update window will prompt
up after click [Update] to save the settings to EEPROM.

Switch

» Upon selecting Switch option, no configuration interface will be prompt up as no
special data needed for input.

» As Switch option request 10 controller with switch firmware, if IO controller is
not programmed with switch firmware, firmware update window will prompt up
after click [Update] to save the settings to EEPROM.

AOUT 1 & AOUT 2 Channels

Both AOUT1 and AOUT2 have the same drop-down options -

I0 Controller Application Type Configuration
LDSU
UUID LCo6R10101642200099 LDSU ID

Product Mame |LDSBus Isolated IO Controller LDSU Termination [Off

Output
AQUT1:

LVIPRN Coneric AOUT
@-10V Dimmer
VBRI 110V Dimmer
Tunable White
LU Tunable White + Dimmer

Number of Bytes Left: 124

Update

o None - Not Configured
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Generic AOUT - General Analog Output configuration

0-10V Dimmer - To configure 0-10V Dimmer

1-10V Dimmer - To configure 1-10V Dimmer

Tunable White - To configure Tunable White

Tunable White + Dimmer - To configure Tunable White + Dimmer

O O O O O

0-10V Dimmer / 1-10V Dimmer

» The LDSBus Isolated IO Controller supports 0-10V and 1-10V application types.
Upon selecting 0-10V / 1-10V Dimmer, the respective configuration interface is
displayed.

Dimmer @ To 16V Sensor Dimmer 1 to 18V Sensor

Settings Settings

21 ADC Data (9~1023):
Each entry represents
5% brightness

22 ADC Data (0~1023):
Each entry represents
4.5% brightness

Separate each data

; N i Separate each data
point with new line

point with new line

Input Data

Input Data
From CSV

From CSV

21 Data .
22 Data

Set Data
Set Data

The user has to input a brightness curve. A brightness curve attempts to compensate
for the non-linearities of the lighting element (e.g., incandescent bulb, CCFL, LED).
There are 2 steps to perform. In the first step, the user has to obtain the brightness
curve from the manufacturer. This brightness curve shall provide information for
Luminance (Brightness) in units of Lux versus the 0-10V or 1-10V input. In the
second step, the user shall then divide the Brightness range (0 Lux to Maximum Lux)
into 21 or 22 equal points. For each point the corresponding voltage may be picked
from the brightness curve. Then this voltage (Analog_Voltage) shall be converted
into an ADC value through the following formulae:

a. 0-10V:
ADC value = Analog_Voltage/10 * 1023

b. 1-10V:
ADC value = Analog_Voltage/9 * 1023

For example, if the brightness curve of a 0-10V light has example value pairs as
follows:

0 Lux, OV
10 Lux, 1V
50 Lux, 2V
100 Lux, 3V
200 Lux, 4V
400 Lux, 5V
400 Lux, 6V
400 Lux, 7V
400 Lux, 8V
400 Lux, 9V
400 Lux, 10V

Fo i (= BN ( B a Yo B @ o}

Then the brightness range is between 0-400Lux and the 21 Lux points will each have
a step of 20 Lux (400Lux/20). For each Lux point, the analog input voltage can be
interpolated from the above table. For e.g. At 50% brightness, the Lux value is 200
and this corresponds to 4V. The corresponding ADC value is:
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ADC = 4/10 * 1023 = 409 (rounded to the nearest integer)

For example, if the brightness curve of a 1-10V light has example value pairs as
follows:

e pl (= Bl B « W0 B w g o))

0 Lux, 1V

10 Lux, 2V
50 Lux, 3V
100 Lux, 4V
200 Lux, 5V
400 Lux, 6V
400 Lux, 7V
400 Lux, 8V
400 Lux, 9V
400 Lux, 10V

Then the brightness range is between 0-400Lux and the 22 Lux points will each have
a step of 19 Lux (400Lux/21). For each Lux point, the analog input voltage can be
interpolated from the above table. For e.g. At 75% brightness, the Lux value is 300
(linear interpolation) and this corresponds to 5.5V. The corresponding ADC value is:

ADC = 5.5/9 * 1023 = 625 (rounded to the nearest integer)

Tunable White

>

Upon selecting Tunable White, the
displayed.

Tunable White Sensor
Settings
Voltage Range:
Min Color Temp:
Max Color Temp:
22 ADC Data (©~1023):

Each entry represents
4.5% brightness

Separate each data
point with new line

Input Data
From CSV

22 Data

respective configuration interface is

Set Data

The LDSBus Isolated I0 Controller supports 0-10V and 1-10V voltage range, you
can refer 0-10V Dimmer /1-10V Dimmer configuration for detailed explanation.

Upon changing the settings (if any), click [Set Data] to save the settings.
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Tunable White + Dimmer

» Upon selecting Tunable White + Dimmer, the respective configuration interface
is displayed.

Tunable White Dimmer Sensor

Settings

Voltage Range: 1-1ev v
Min Color Temp: 2000 Max Color Temp: [3%1)

Color Temp CH1 Setting: Brightness CH2 Setting:

22 ADC Data (@~1823): 22 ADC Data (@~1023):
Each entry represents Each entry represents
4.5% temp 4.5% brightness

Separate each data Separate each data
point with new line point with new line

Input Data Input Data
From CSV From C5V

22 Data 22 Data

Set Data

» The LDSBus Isolated IO Controller supports 0-10V and 1-10V voltage range, you
can refer 0-10V Dimmer /1-10V Dimmer configuration for detailed explanation.

» Tunable White + Dimmer required to use both Analog output channels, channel
1 is for colour temperature setting and channel 2 is for brightness setting. Please
input the data correctly.

» Upon changing the settings (if any), click [Set Data] to save the settings.

DOUT 1 & DOUT 2 Channels

Both DOUT1 and DOUT2 have the same drop-down options -

I0 Controller Application Type Configuration
LDSU
UUID LCe6010101042200897 LDSU ID 97

Product MName LDSBus Isolated IO Controller LDSU Termination Off

Output

Generic AIN UM 1-10Y Dimmer ~

None

None DCIPERN Coneric DOUT

Number of Bytes Left: 69

Update

o None - Not Configured
o Generic DOUT - General Digital Output configuration

In the event that the configuration space is limited, an appropriate message will be displayed
to indicate that there is not enough EEPROM space to configure the application type.
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8.3 Trailing Edge Dimmer Profile Setting

To configure profile setting for LDSBus Trailing Edge Dimmer -

1. Click [Profile Settings].

File LDsSU Commands

File LDSU Commands

LDSBus Configuration Utility-LDSU Project

LDSU Port Power

al Number
Product Name
LDSU Class
Manufacture Date
Calibrated Current (mA)
Calibrated Volt. (mV)
Calibrated Temperature (°C)
Calibr Date
Number of I2C Devices

Software Ver

I2C Devices

Manufactur

Firmware Update About

L

LCo

LDSU ID
D81CCO6F

LDSU Te
LDSBus Trailing Edge Dimmer

Nickname
Bx

65

Not Applicable

LDSBus Configuration Utility-LDSU Project

LDSU Port Power
Status: On

LDSU

uuIp

Serial Number

Product Name

LDSU Class

Manufacture Date
Calibrated Current (mA)
Calibrated Volt (mv)
Calibrated Temperature (
Calibrated Date

Number of I2C Devices

Software Version

Devices

Firmware Update

Enable

LC
LDSU ID
D81CCO6F

LDSU Termination

LDSBus Trailing Edge Dimmer
Nickname
oxa

Select Profile
KEA_LED1632G5
Brand: IKEA
Model: LED1

Not Applicable

LDSBus Trailing Edge Dimmer

LDSBus Trailing Edge Dimmer
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3. Click on the Select Profile drop down box and select a different default profile. Depending upon
the selected profile, the details are displayed. For example, if the selected profile is
IKEA_LED1632G5, then the brand name and model is displayed.

File

File

Upon selecting the

LDSBus Configuration Utility-LDSU Project

LDSU Commands Firmware Update

LDSU Port Power

Enable

LCt 101¢€
D81CCO6F
Bredek e LDSBus Trailing Edge Dimmer
LDSU Class
Manufacture Date
Calibrated Current (
Calibrated Voltage (
Calibrated Temperature

Calibrated Date Not Applicable

Number of T2C Devices 2

Software Version

2C Devices

Capability
Report Rate :
Class ID :

Capability
Report Rate
Class ID :

1000 ms

LDSBus Configuration Utility-LDSU Project

LDSU Commands Firmware Update

LDSU Port Power

Status: On Enable

LDSU
uuID LCO3810185:

Serial Number D81CCOBF

Product Name LDSBus Trailing Edge Dimmer
LDSU Class 8x4000

Manufacture Date 2022-0ct-17

Calibrated Current (

Calibrated Voltage (

Calibrated Temperature e

Calibrated Date Mot Applicable

Number of I2C Devices 2

Software Ve
2C Devices

PartNumber
Add 3
Capability
Report Rate
Class ID

Report Rate :
Class ID

LDSU ID

LDSU Termination

Nickname

Select Profile

IKEA LED1632G5

Aeon_D70036NTF

Aeon_HALO-V2
Aeon_ISA_V3_Sand_White

Generic

TKEA LED1632G5

Oranlife X@917EMCVV_LED 240V _S5@Hz
OSRAM_9633-SWH-600K

Philips_4.9W

Philips_5923431U0

RS_PRO_Halogen_Lamps_248V_58Hz_40@W

Zhuhai_ShengChang_KVF-12068-TDWS

LDSU ID

LDSU Termination
Nickname
Update
Select Profile
EA_LED1632G5
Brand: IKEA
Model:

LDSBus Trailing Edge Dimmer

Update Setting

profile, click [Update Setting] to update the profile to the EEPROM. Once the

profile has been successfully updated, the utility will return to the main window.
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8.4 RFID Configuration Settings

To configure RFID setting for LDSBus RFID Reader -

1. Click [RFID Settings].

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update

LDSU Port Power

LDSU

Settings  About

Enable

UUID LCO5816107142200806

Serial Number @147CEBG
Product Name 5y
LDSU €

Manufacture Date

Calibrated Current (mA)

Calibrated Tempera
Calibrated Date Not Applicable
Number of I2C Devices 1

Software Version 2.7

I2C D

Manufacturer : BRT Systems Pte Ltd.
PartNumber AIOT

Addres

Capability :

RFID Reader

LDSU ID

LDSU Termination

Nickname

RFID Settings

LDSBus RFID Reader

2. The RFID setting window will pop up with the current settings as shown in the picture below.

RFID Setting
LDsU
UuID

Product MName
LDSU ID

LDSU Termination

RFID Mode Setting

LCa5818187142288086

LDSBus RFID Reader

126

off
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3. Change the settings by clicking on the checkbox to enable or disable buzzer, low freq. mode and
high freq. mode; Click [Save] to save the new settings to the device (if any).

RFID Setting
LDSU
UuID LCa5818187142208808006

Product MName LDSBus RFID Reader

LDSU ID

LDSU Termination

RFID Mode Settin,

8.5 LDSBus Modbus/SDI-12 Adapter Configuration Settings

To configure LDSBus Modbus/SDI-12 adapter to specific sensors -

1. Click [Sensor Configuration].

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings

LDSU Port Power

Enable

LDSU
wUID LA14018108122400001

LDSU ID -
00001001

Serial Number
LDSU Termination >
- LDSBus Modbus/SDI-12 Adapter
Product Name b P . :
reduct Hame Nickname LDSBus Bonad 7inl Soil Senso
LDSU Class [erditeals
Update

Manufacture Date 2024-Aug-12

Calibrated Current (mA) ge
Calibrated Volt

Calibrated Temperature 25

Calibrated Date Not Applicable

Number of I2C Devices e

— Sensor Configuration
Software Version 2.2

I2C Devices

Manufacturer : BRT Systems Pte Ltd. Manufacturer : Microchip Technology Inc
PartNumber : BRT-VDEV PartNumber

Address : Ox@@ Address

Capability : @ Capability

Report Rate 1888 ms Report Rat

Class ID 91 £
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2. The setting window will pop up.

LDSBus Modbus/SDI-12 Adapter Setting LDSBus Modbus/SDI-12 Adapter Setting

Sensor Info

UuID LA140108188122406001

Sensor Info

UuID LA14010108122400001

Product Name LDSBus Modbus/SDI-12 Adapter = =
Product Name LDSBus Modbus/SDI-12 Adapter

LDSU ID 11

LDSU ID 11

Sensor Name Honde 7inl Soil Sensor
Sensor Name Honde 7inl Soil Sensor

Sensor Type

EELET TG RYT-H | DSBus Honde 7inl Soil Sensor v

EELEGIGNEYEH B L DSBus Honde 7inl Soil Sensor v
Update

LDSBus Honde 7inl Soil Sensor
LDSBus Honde 2inl Soil Sensor
LDSBus Bonad 7inl Soil Sensor
LDSBus 2inl Soil Sensor

Probe Info LDSBus 3inl Soil Sensor

Probe Info
Baudrate: 9600

Sensor Address: [l Baudrate:

3. Click on the Sensor Type drop down box and select a different type of sensor configuration.

4. Upon selecting the Sensor configuration, click [Update] to update the new setting to the sensor.
Confirmation window will pop up for user input, click [Yes] update the configuration.
Alternatively, click [No] to cancel the update.

LDSBus Modbus/SDI-12 Adapter Setting

Firmware release note

[Readme Generated automatically on Mon 08/04/2024_15:23:49.08]

Sensor Info Introduction

UuID LA14010108122400001

This is the release note for LDSBus_Bonad_7in1_Soil_Sensor and related assets.
LDSBus_Bonad_7in1_Soil_Sensor Fimware Package Contents

Product Name LDSBus Modbus/SDI-12 Adapter Product |0 - 0x8D1E

Firmware Version : (x22
LDSU ID 11

This firmware is released for production use

Firmware changes:

r Name Honde 7inl Soil Sensor
Fixes
ensor Type - None

Mew features

SELEGIR YR | DSBus Bonad 7inl Soil Sensor ~

Update

- added variable modbus baud rate (1200bps - 115200bps) & modbus slave address

- added support for hardware fault detection fault & startup, fault at runtime)

- added support for fimmware fault detection {under/over voltage at startup, under/over
voltage at runtime)

- added power management module for voltage monitoring & control (medes: firmware,
manual on, manual

-load defautt settings from EEFROM at starttup (baud rate, slave address, output
voltage, min / max voltage, startup/runtime voltage monitoring time)

-removed LED control

- added Modbus slave id detection

Probe Info

Baudrate:

9600

Enhancements

5. If firmware has release note, firmware release note will pop up. Click [OK] to continue.
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6. A progress bar indicating that the update has started is displayed.

LDSBus Modbus/SDI-12 Adapter Setting

LAl4@1el1e81224800801
Product Name LDSBus Modbus/SDI-12 Adapter
LDSU ID 11
Sensor Name Honde 7inl Seil Sensor

Sensor Type

FELELT SRR - | DSBus Bonad 7inl Soil Sensor ~

Probe Info

-

Sensor Address:

7. Upon successful completion of the update, an appropriate message indicating the same will be
displayed. Click [Ok] to return to soil sensor setting window.

Configuration Update Done
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8.6 LDSBus 4CH SSR Application Type Configuration

To configure application type for 4CH SSR Module -

1. Click [Application Type Configuration].

LDSBus Configuration Utility-LDSU Project

File LDSU Commands

LDSU Port Power

rial Number
Product Name
LDSU Class
Manufacture Date
Calibrated Current (mA)
Calibrated Voltage (mV)
Calibrated Temperature
Calibrated Date
Number of I2C Devices

Software Version

I2C Devices

Manufacturer : BRT Systems
PartNumber : BRT-VDEV
Address : @x@e

Capability : @

Report Rate 10900 ms
Class ID : 9x0000@

Firmware Update Settings

M Enable

LCO1620129112300007
FD6BEDBA
LDSBus 4CH Solid State Relay

Ox4002

81
5200
25

Not Applicable

Pte Ltd. Manufacturer :
PartNumber :
Address : @x78
Capability : @
Report Rate
Class ID : @

About

LDSU TID

LDSU Termination off -

Nickname

BRT Systems Pte Ltd.
4CH Solid State Relay

Manufacturer :
PartNumber LM75
Address 48
Capability : @

Report Rate 5000 ms
Class ID

LDSBus 4CH Solid State Relay

Update

Application Type Configuration

NXP Semiconductors

ox0100

2. A window will appear asking for a new configuration if the 4CH SSR board was configured
previously. Click [Yes] to change the setting; [No] to not change the setting.

Application Already Configured For This Device, Do

You Want To Configure Again?

Alternatively, if the 4CH SSR has not been configured previously, this window will not appear.

Click [Yes] to configure the 4CH SSR application type. If no configuration is done on the board, the
following window will appear.
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3. The Relay Controller Application Type configuration window is displayed.

4 Channel Solid State Relay Board Application Configuration

LDSU
VUID LCB1020129112300087 LDSU ID 7

Product Mame LDSBus 4CH Solid State Relay LDSU Termination [Off

Relay Setting

Update

Only “Generic DOUT” selection is supported for the channels. Other selections are deprecated and not supported.
Select ‘Yes’ to save the selection and the utility will show the data update is successful.

Confirm Application Update? Application Data Update Successful!
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9 Contact Information

Refer to https://brtsys.com/contact-us/ for contact information.

System and equipment manufacturers and designers are responsible to ensure that their systems, and any BRT Systems Pte Ltd
(BRTSys) devices incorporated in their systems, meet all applicable safety, regulatory and system-level performance
requirements. All application-related information in this document (including application descriptions, suggested BRTSys devices
and other materials) is provided for reference only. While BRTSys has taken care to assure it is accurate, this information is
subject to customer confirmation, and BRT Systems disclaims all liability for system designs and for any applications assistance
provided by BRTSys. Use of BRTSys devices in life support and/or safety applications is entirely at the user’s risk, and the user
agrees to defend, indemnify, and hold harmless BRTSys from any and all damages, claims, suits, or expense resulting from such
use. This document is subject to change without notice. No freedom to use patents or other intellectual property rights is implied
by the publication of this document. Neither the whole nor any part of the information contained in, or the product described in
this document, may be adapted, or reproduced in any material or electronic form without the prior written consent of the
copyright holder. BRT Systems Pte Ltd, 1 Tai Seng Avenue, Tower A, #03-01, Singapore 536464. Singapore Registered Company
Number: 202220043R.
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Appendix A - Command List
Commands with payload / response

READN

This command is used to read multiple consecutive bytes from an I2C device.

LDSBus Configuration Utility-1DSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID

Commands

Command

READN Payload :40
Checksum
I2C Address (Hexadecimal)

ee

Register Address (Hexadecimal)
i

Count (Decimal)

WRITEN

This command is used to write multiple consecutive register locations in an I2C device.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Ta t LDSU

LDSU ID

Commands

Command

WRITEN v Chnck;um

12C Address (Hexadecimal)

s (Hexadecimal)

Data (Hexadecimal, Bytes seperated with Space or '

21 02 @3 e4 o5
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READ

This command is used to read an I2C device register.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID

Commands Response
Device ID
Command Payload

READ 2

I2C Address (Hexadecimal)

ECHO

The addressed device, if present, shall echo the bytes from the host controller. This command is a
special command to check the communication.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID

Commands

Command

Data (String - Max 32

8123456789

Send
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Commands without payload /response

RESET

This command will reset the LDSU module.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID

Commands Response
<Command without response>

Command

RESET ~

Send

IDENTIFY
This command will trigger the LED in the LDSU Device.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About
Settings and more (£

tTarget 1S 4970707 7 4 77 - 7 ¥ ¥ ¥—————Dm20—21—0—/—— — 00—

LDSU ID 126 (@x7E)

Commands Response

<Command without response>

Command

IDENTIFY

Send
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I2CREGOFF

This command will turn off the 16bit register access

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID 15 (@xeF)

Commands R onse

<Command without re:

Command

SETI2CREGOFF v

Send

- 11:05:21.4526389

Commands with payload / without response

I2CREGON

This command sets the 12C register addressing to 16-bit mode.

LDSBus Configuration Utility-LDSU Project

File LDSU  Commands Firmware Update Settings About

rTarget S ——m87878 —

LDSU ID 15 (OxerF)

r Commands

thout res
Command

SETI2CREGON v

Register MSB (Hex)

Send
L3

je Logger - 11:05:21.4526389

87

Product Page
Document Feedback Copyright © BRT Systems Pte Ltd


https://brtsys.com/resources/software/brtsys-utility-tools
mailto:docufeedback@brtchip.com?subject=Document%20Feedback:%20BRTSYS_AN_001%20Version%201.5

BRTSYS_AN_001 LDSBus Configuration Utility Guide
Document Version 1.5

-a BR I Sys Document Reference No.: BRTSYS_000014 Clearance No.: BRTSYS#038

SETI2CSPEED
This command is used to set the I12C Speed (100 KHz or 400 KHz).

LDSBus Configuration Utility-LDSU Project

File LDSU Commands. Firmware Update Settings About

Ta LDSU

LDSU ID

Commands Response

<Command without response>
Command

SETI2CSPEED &

12C Speed

400KHz v

Send

15:55:50.5680174

WRITE

This command is used to write a single register location in an I2C device.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Ta t LDSU

LDSU ID

Commands Response

<Command without ponse>
Command

WRITE ~

12C Address (Hexadecimal)

ess (Hexadeciaml)

R er res

Data (Hexadecimal)
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Commands without payload / with response

INFO

This command will get the information about the LDSU Module.

LDSBus Configuration Utility-LDSU Project

File LDSU | Commands Firmware Update Settings

Target LDSU

LDSU ID

Commands

Command

INFO &

Send

STATUS

About

Checksum

This command will get the last sent command status.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands. Firmware Update Settings

Target LDSU

LDSU ID

Commands

Command

STATUS i

Send

- 15:55:508.5686174

About

Response
Device ID
Payload :

Al-C6-82-05-02-DC-00-ED-00-20-00
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GETUUID

This command will get the device's unique UID.

LDSBus Configuration Utility-LDSU Project

File LDSU Commands Firmware Update Settings About

Target LDSU

LDSU ID

Commands

Command

GETUUID &2

1-4A-00

Send
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Appendix B - References

Document References

LDSBus Configuration Utility User Guide

LDSBus Python SDK on IDM2040 User Guide

Acronyms and Abbreviations

Terms Description
LDSU LDSBus Units

LDSBus Long Distance Sensor Bus
usB Universal Serial Bus
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